
Appendix A. FUI Screen Descriptions 

A.1. User Customization Window


A.1.2 Application Colors & Fonts Customization Dialog


A.1.3 Dynamic Page Color Customization Dialog


A.1.4 Printer Customization Dialog


A.1.5 Data Directory Customization Window


A.1.6 Screen Snapshot Customization Dialog


A.1.7 Room Customization Dialog


A.1.8 Control Windows


A.1.9 Login Screen & User Type Dialog


Tools


A.2.1 Quick Message Generator


A.2.2 Data Mover


A.2.3 Replay Controller


A.2.4 Document Reader


A.2.5 Display Builder


A.2.6 Help


A.2.7 Procedure Builder/Procedure Editor


A.2.8 Command Builder


A.2.9 Reports


A.2.9.1 Report Selector


A.2.9.2 Periodic Report Selector Dialog


A.2.9.3 On Demand Report Selector Dialog


A.2.9.4 Custom Report Dialog


A.2.9.5 Report Browser Dialog
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A.2 



A.3 Utilities


A.3.1 Time Selector


A.3.2 Selection Filter


A.4 Command Management Displays


A.4.1 Table Load Builder


A.4.2 RTS Load Builder


A.4.3 Ground Script Display


A.4.4 ATC Buffer Display


A.4.5 RTS Buffer Display


A.5 Command Displays


A.5.1 Procedure Control


A.5.2 Command Control


A.5.3 Command Monitor


A.5.4 Command Request Generation


A.5.5 Command Request Status


A.6 Telemetry Displays


A.6.1 Alphanumeric Windows


A.6.2.1 Graph


A.6.2.2 Graph Format Dialog


A.6.3.1 Table


A.6.3.2 Table Format Dialog


A.6.4 Schematic


A.6.5 Combined


A.6.6.1 Telemetry Attributes


A.6.6.2 Telemetry Attributes Format Dialog


A.6.7 Status Window


A.6.8 SSR Analysis Window


A.7 Resource Management Displays


A.7.1 Data Source Selector
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A.8 Analysis


A.8.1 Request


A.8.2 Status


A.8.3 Product Format


A.8.4 Standing Order Browser


A.8.5 Quick Analysis


A.8.6 Algorithm Registration


A.8.7 Algorithm Request


A.9 Data Management


A.9.1 Event Display


A.9.2 Event History Request
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A.1 User Customization Window


Figure A.1-1. User Customization Window 

A.1.1 User Customization Window Usage 

The User Customization window is used to bring up other customization dialogs which allow the 
user to modify the application environment to suit his/her preferences. 

A.1.1.1 User Customization Access 

The User Customization dialog can be accessed from the Room Controller. 

A.1.1.2 User Customization Input 

The User Customization dialog contains five buttons which are used for selecting the type of 
modification to edit: 

1. Data Directories, which invokes the Data Directory Customization dialog. 

2. Screen Snapshot, which invokes the Screen Snapshot Customization dialog. 

3. Printer, which invokes the Printer Customization dialog. 

4.	 Dynamic Page Color Intensities, which invokes the Dynamic Page Color Intensities 
Customization dialog. 

5.	 Application Colors & Fonts, which invokes the Application Colors & Fonts 
Customization dialog. 
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The User Customization dialog also contains a "command area" which consists of a Close button 
as described below: 

Close dismisses the dialog. 

A.1.2 Application Colors and Fonts Customization Dialog 

Figure A.1.2-1. Application Colors & Fonts Customization Dialog 

A.1.2.1 Application Colors & Fonts Customization Dialog Usage 

The Application Colors & Fonts Customization dialog is used to: 

•	 select the colors for the configurable window attributes (foreground, background, top 
shadow color, and bottom shadow color). 

• select a monospace font for use in displays that require characters to be of uniform width. 

• select a font for use in the interface where such a restraint does not apply. 
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A.1.2.2 Application Colors & Fonts Customization Dialog Access 

The Application Colors & Fonts Customization dialog can be accessed from the User 
Customization dialog by pressing the pushbutton labeled "Application Colors & Fonts". 

A.1.2.3 Application Colors & Fonts Input 

The Application Colors & Fonts Customization dialog has four different input components: 

1.	 The Color Selector, where the user can select a window attribute and set its color. The 
selection is performed within a list box. The color may be set using the scales. 

2.	 The Monospace Font list box, where the user can select a font to be used where a fixed­
width font is required for display. 

3.	 The General Purpose Font list box, where the user can select a font for use where a fixed­
width font is not required. 

4. The "command area", where the user can select Apply, Default, Cancel, or Help. 

A.1.2.4 Application Colors & Fonts Output 

The Customization Preview area, where changes to any of the first three components are 
immediately displayed. 

A.1.3 Dynamic Page Color Customization Dialog 

Figure A.1.3-1. Dynamic Page Color Customization Dialog 
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A.1.3.1 Dynamic Page Color Customization Dialog Usage 

The Dynamic Page Color Customization dialog is used to set the intensities for the colors used in 
dynamic pages. 

A.1.3.2 Dynamic Page Color Customization Dialog Access 

The Dynamic Page Color Customization dialog can be accessed from the User Customization 
dialog by pressing the pushbutton labeled "Dynamic Page Color Intensities". 

A.1.3.3 Dynamic Page Color Customization Input 

The Dynamic Page Color Customization dialog contains the following sources of input: 

1. A list box of available colors to adjust 

2. A scale for adjusting or entering in the intensity of the color. 

3. An area for Apply, Default, Cancel and Help buttons. 

A.1.3.4 Dynamic Page Color Customization Output 

The Customization Preview area, where changes to a color's intensity will be shown. 

A.1.4 Printer Customization Dialog 

Figure A.1.4-1. Printer Customization Dialog 

A.1.4.1 Printer Customization Dialog Usage 

The Printer Customization dialog is used to set the default printer used for print operations. 
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A.1.4.2 Printer Customization Dialog Access 

The Printer Customization dialog can be accessed from the User Customization dialog by 
pressing the pushbutton labeled "Printer". 

A.1.4.3 Printer Customization Input 

The Printer Customization dialog has a single list box which is used to select the new default 
printer. 

It also has a "command area" which contains Apply, Default, Cancel, and Help pushbuttons. 

A.1.4.4 Printer Customization Output 

The Printer Customization dialog has a single label which outputs the current printer in use by 
the system as of the time the dialog was created. 

A.1.5 Data Directory Customization Window 

Figure A.1.5-1. Data Directory Customization Window 

A.1.5.1 Data Directory Customization Dialog Usage 

The Data Directory Customization dialog is used to set the directories used for room information, 
page information, screen snapshots, reports, and analysis products. 
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A.1.5.2 Data Directory Customization Dialog Access 

The Data Directory Customization dialog can be accessed from the User Customization dialog 
by pressing the pushbutton labeled "Data Directories". 

A.1.5.3 Data Directory Customization Input 

There are five text fields used for user input of the directory names. 

The dialog also contains a "command area" which contains Apply, Default, Cancel, and Help 
pushbuttons. 

A.1.6 Screen Snapshot Customization Dialog 

Figure A.1.6-1. Screen Snapshot Customization Dialog 

A.1.6.1 Screen Snapshot Customization Dialog Usage 

The Screen Snap Customization dialog is used to set the destination for a screen snap operations. 

A.1.6.2 Screen Snapshot Customization Dialog Access 

The Screen Snap Customization dialog can be accessed from the User Customization dialog by 
pressing the pushbutton labeled "Screen Snapshot". 

A.1.6.3 Screen Snapshot Customization Input 

The Screen Snapshot Customization dialog contains three radio buttons representing the user's 
available destinations for a screen snapshot (Printer, File, or both). 

The dialog also has a "command area" which contains Apply, Default, Cancel, and Help 
pushbuttons. 
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A.1.7 Room Customization Dialog 

Figure A.1.7-1. Room Customization Dialog 

A.1.7.1 Room Customization Dialog Usage 

The Room Customization dialog is used to select the "default" rooms for the user. 

A.1.7.2 Room Customization Dialog Access 

The Room Customization dialog can be accessed from the User Customization dialog by 
pressing the pushbutton labeled "Rooms". 

A.1.7.3 Room Customization Input 

The Room Customization dialog contains two listboxes. The left list contains a list of available 
room settings for the user to select from. The list on the right shows the current rooms used as 
the user's default rooms. 
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The dialog also has a "command area" which contains Apply, Default, Cancel, and Help 
pushbuttons. 

A.1.8 Control Window 

Control Window 

Events: ECL: 

F1 

Rooms 

F2 F3 F4 

Help Tools Windows Filter Tile Default Procs 

F7 F6 F5 

Mini Ctrl 

Figure A.1.8-1. Control Window 

Mini Control Window 

ECL: 

Rooms Help Tools Windows Tile Default Procs 

Control 

Figure A.1.8-2. Mini Control Window 

A.1.8.1 Control Window Usage 

Control window is used by the operator to manage the IST functions. It provides a set of 
function buttons that are used to gain quick access to rooms, windows, and IST functions. 

The Control window (Figure A.1.8-1) is the default control window which will displayed at the 
bottom of the screen at user login. The right side of the Control window displays events 
information. It also contains seven user customizable buttons. For users who already have an 
event display window on the screen and do not need the customizable buttons, the Mini Control 
window (Figure A.1.8-2) can be used by selecting the 'Mini Ctrl' button in the Control window. 
User can switch the Mini Control window back to the default Control window by selecting the 
'Control' button in the Mini Control window. 

A.1.8.2 Control Window Access 

The Control window is displayed upon user login. This window is always available to the IST 
user. 

A.1.8.3 Control Window Input 

The Control window contains a command line area that allows the user to issue command 
directives, unix command directives, or screen directives from a workstation keyboard. 
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F1-F7 buttons are user customizable buttons.


Tile button arranges, re-sizes, and displays all the windows on the screen without any

overlapping.


Default button displays all the windows of a room on the screen in their default setting.


Windows button handles the user's selection of a window.


Rooms button invokes the room selection window.


Tools button invokes the tools selection window.


Procs button handles the user's selection of a procedure.


Help button invokes a help page.


Mini Ctrl button switches the Control window into the Mini Control window (Figure A.1.8-2).


Control button in the Mini Control window (Figure A.1.8-2) switches the Mini Control window

back to the default Control window (Figure. A.1.8-1).


Events text widget displays the four most recent event messages.


Filter button initiates the event filter functions.


A.1.8.4 Control Window Output 

The Control window executes directives entered at the command line. It also allows the user to 
manage the desktop environment according to user's selection. 
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A.1.9 Login Screen & User Role Dialog 

Welcome To ECS Flight Operation 

Login : 

Password : 

OK Clear Help 

Mode : Operation 

Figure A.1.9-1. Login Screen 

User Role Dialog 

OK HelpCancel 

Operations coordinator 
Ops controller 

Command activity controller 

Spacecraft engineer 

Software maintenance engineer 

Database manager 

System specialist 

Ground systems engineer 

Instrument planner 

Spacecraft planner 

Command management analyst 

Mission supervisor 
Mission planner 

Instrument engineer 

Flight systems engineer 

Spacecraft evaluator 

Instrument controller 
Instrument evaluator 

Spacecraft activity controller 

Ground controller 

Shift supervisor 

Figure A.1.9-2. User Role Dialog 
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A.1.9.1 Login Screen & User Role Dialog Usage 

The FOS login screen (Figure A.1.9-1) allows the user to enter the user name and password to be 
verified and select the login mode. If the authentication fails, a warning dialog will be opened 
that shows "Login Failed" message. If the authentication succeeds, a user role list dialog (Figure 
A.1.9-2) will be opened. The user role list dialog allows the user to select a user role in the 
current session. 

A.1.9.2 Login Screen & User Role Dialog Access 

The FOS login screen can be accessed at the system start up time. 

The user role list dialog can be accessed either after the user is authenticated or from the tools 
button on the command window. 

A.1.9.3 Login Screen & User Role Dialog Input 

The login screen contains two text fields, one option menu, and three push buttons. The two text 
field include: 

Login field : The user enters user name. 

Password field : The user enters user password. 

The Mode option menu : There will be three login mode option : operation, test, and 
development. These three options will be used by the environment controller to set up the 
different UNIX working environments . 

The four push buttons include: 

OK : Will invoke user name and password authentication checking. Upon checking 
failed, a warning dialog will be opened. Upon checking succeeded, the login window will 
be closed and the user role list dialog will be opened. 

Clear : Will clear the login text field and the password text field. 

Help : Will open a context sensitive help window. 

The user role list dialog contains a list of user roles and three buttons. The user can select the role 
from the list and press the button to take action. These buttons include : 

OK : Will apply the new role selection and close the dialog. 

Cancel : Will cancel the new role selection and close the dialog. This button is available 
only when the user changes to a new role. (Invoked from the tools button on the 
command window). 

Help : Will open a context sensitive help window. 

A.1.9.4 Login Screen & User Role Dialog Output 

The user role selection dialog will send the user information (including the user name, role, and 
environment) to the FUI environment controller. 
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A.2.1 Quick Message Generator 

A.2.1.1 Quick Message Generator Usage 

The Quick Message Generator window allows a user may send a message of up to 240 characters 
as an event. The message types may be: information, a warning, or an emergency. Once sent to 
Data Management, the event is then broadcast to workstations. This event can then be seen in the 
Control window in the events scrolling window, and in the Event Display. 

Figure A.2.1-1. Quick Message Generator Dialog 

A.2.1.2 Quick Message Generator Access 

The Quick Message Generator window is brought up from the Tool Selector window that is

invoked from the Control window.


A.2.1.3 Quick Message Generator Input


The Quick Message Generator has a message type out of which one may be chosen:


Message Type: 

Information 
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Warning 

Emergency 

The text message area has an area where text can be entered up to 240 characters. 

Send: Sends the text message to Data Management, who formats it into an event for display. 

Cancel: Quits the window with no action.


Help: Calls the Help window for Quick Message Generator.


A.2.1.4 Quick Message Generator Output 

When the Send button on the Quick Message Generator window is pressed, the message is sent 
to Data Management, who formats it into an event for display. 

A.2.2 Data Mover Window 

A.2.2.1 Data Mover Usage 

The Data Mover window is used by the user to transfer files. The transfer locations include the 
EOC and IST sites. The user may specify to send, receive or delete 1 or more files. Files may be 
selected to sent to multiple destinations. 
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Data Mover 

Find 

----> 

Selected FilesAvailable Files 

File Name 

All---> <--­ <---All 

Apply Cancel Help 

File Option: 

Send 

Receive 

Delete 

File Source: 

Directory: 
Location 

/home/data 

JPL,LARC 

File1 

File2 
File3 

File4 

File5 

File6 

File7 

File6 

File7 

File2 

File3 

Location: 

JPL,LARC 

JPL,LARC 

JPL,LARC 

JPL,LARC 

Status 

Sending Files... 

Figure A.2.1-1. Data Mover Window 

A.2.2.2 Data Mover Access 

The Data Mover window can be accessed from the Control Window. 

A.2.2.3 Data Mover Input 

The Data Mover Window allows the following inputs: 

•	 Selection of source directory. The user must enter a directory path to get a list of 
available files. A list of available source directories/categories will be available. 

• Selection of file option. The user chooses files selected be sent, received or deleted. 

•	 Selection of location. The user must enter a location for files to be transferred. A list of 
available transfer locations will be provided. 
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A.2.2.4 Data Mover Output 

The Completion Status will be displayed. Completion status will be one of the following: 

• Started- indicating that the request was initiated. 

• Complete- indicating the request was successful. 

•	 Error- indicating that an error occurred for a particular file. An error message will be 
displayed for each file in error. 

The "OK" button sends/receives or deletes the selected files. 

The "Cancel" button ignores any inputs and closes the Data Mover window. 

The "Help" button and pull-down menu provide context-sensitive help. 

A.2.3 Replay Controller 

A.2.3.1 Replay Controller Usage 

The Replay Controller (Figure A.2.3-1) is used by the Flight Operations Team (FOT) and 
Instrument Operations Team (IOT) members to establish a shared (Ground Controller only) or 
dedicated replay string and to control the replay of the archived telemetry data via that string. 
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Replay Controller 

Close 

Play 

Help 

Replay String Specification 

AM-1 

Data Base: 

Spacecraft: 

ArchiveTelemetry Specification 

Replay Type: Dedicated 

Start Time: 

Stop Time: 

Select Time 

Replay Rate (Kbps):16 

Step Interval (seconds):2Begin Time: 

095/10:00:00 

095/12:00:00 

095/10:00:00 095/12:00:00 

095/10:00:00 

095/10:30:00 

Pause Step Reset 

<<Status Messages>> 

Data Type: Housekeeping 

Default 

Cancel 
Request 

Submit 
Request 

Stop 

Figure A.2.3-1. Replay Controller Window 

The Replay Controller window is divided into two major sections. The top section is used to 
define the replay request. The bottom section is used to control the replay once the resources 
(i.e., the logical string components) required for the replay have been allocated. The user inputs 
to define the replay request and to use the control functions are described in Section A.2.3.3 
below. 

A.2.3.2 Replay Controller Access 

The Replay Controller may be accessed by any user from the Tools menu located on the Control 
window (see Section A.1.8). 
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A.2.3.3 Replay Controller Input 

The top section of the Replay Controller window allows the user to specify the parameters for a 
replay request. The Replay String Specification area allows the user to specify parameters 
using a combination of option menus and text fields. These parameters include: 

•	 Spacecraft (option menu) - default value is AM-1. This option menu will contain the 
spacecraft identifier of all operational vehicles. 

•	 Data Base (combo box) - default value is the operational data base corresponding to the 
specified telemetry data. A user may enter the identifier of an alternate data base that will 
be used to decom the telemetry. If the default value is used, data base crossovers will be 
handled automatically. If a specific data base identifier is provided, the replay decom 
process will use the specified data base regardless of any data base crossovers. 

•	 Data Type (option menu) - default value is Housekeeping; other options include 
Health&Safety and Standby. 

•	 Replay Type (option menu) - default value is Dedicated. A user with ground control 
authority may specify a shared replay. If a shared replay is specified, the option will also 
include the identifier of the Real-Time Server (1-3). 

•	 Replay Rate (text field) - default value is 16 Kbps for Housekeeping and 1 Kbps for 
Health&Safety and Standby. The user may enter a number from 1 to 150 (AM-1 
specific) for the replay rate. Two arrow buttons located next to the text field may be used 
to increment or decrement this value. 

The Archive Telemetry Specification area is used to define the time frame of the data to be 
replayed. The user may type in the start and stop time in the respective text fields, or activate the 
Time Selector, via the Select Time button, to specify these values. The Time Selector is further 
defined in Section A.3.1. 

Once the Replay String Specification and Archive Telemetry Specification information has been 
entered, the user must select the Submit Request button to initiate processing of the replay 
request. If the required replay resources are available, the corresponding logical string(s) is 
created. A status message, indicating the success or failure of the replay request, will be 
displayed on the status line located near the bottom of the window. If successful, the top section 
of the Replay Controller is deactivated (i.e., becomes insensitive) since changes to the replay 
configuration are not allowed, and the control functions of the window are activated. If the 
required replay resources are not available, the request is placed in a queue and a Pending status 
message is displayed. The replay request will be processed as soon as the required resources 
become available. The user may cancel a pending replay request by selecting the Cancel 
Request button. 

The bottom section of the Replay Controller window provides the mechanism to control the 
replay. The control features of this window allow the user to pause and resume the replay, as 
well as to step through the replay at a user-specified interval. 

A Begin Time text field allows the user to specify a new start time for the replay. This new start 
time must be a time between the start and stop times specified in the Archive Telemetry 
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Specification area when the logical string was created. The Begin Time field defaults to the 
original start time and may only be modified when the replay is paused. 

A Step Interval text field allows the user to select the interval, in seconds, that will be used to 
step through the replay. When paused, the replay will advance by the value of this field each 
time the Step button is pressed. 

A slider bar shows the user the current time of the replay with respect to the initial start and stop 
times. The slide bar advances when the replay is active. When paused, the user may adjust the 
slider bar to select a new begin time (i.e., modifies the Begin Time text field). 

Five buttons are located just beneath the slider bar. The Play button is used to start the replay 
when it is paused, and the Pause button is used to suspend an active replay. The Step button 
advances the replay by the specified Step Interval. The Stop button terminates the replay and 
allows the user to specify new replay parameters. When the Stop button is selected, the user is 
prompted with a warning dialog, which provides the option to cancel or continue the stop action. 
The Reset button moves the slider bar back to the last specified Begin Time. The Step and 
Reset buttons are active only when the replay is paused. 

Two buttons are located along the bottom of the Replay Controller window. The Close button 
will remove the Replay Controller window, terminating the replay. The user is prompted with a 
warning dialog, which allows the user to cancel or continue the close action. The Help button 
activates a window that provides help information about the Replay Controller. 

A.2.3.4 Replay Controller Output 

The output of the Replay Controller consists of status messages displayed on the status line 
located above the Close and Help buttons. These status messages provide feedback for user 
actions, such as the success or failure of a replay request and the occurrence of data base 
crossovers. 

The logical string created as a result of using the replay controller will be reflected in the Data 
Source Selector. The Data Source Selector (reference Section A.8.1) allows a user to connect 
dynamic pages to a logical string. Multiple logical strings will be created if data base crossovers 
occur (one additional logical string per crossover). If a data base crossover is detected, the replay 
will automatically pause to allow the user to manually switch the logical string assignment of any 
dynamic pages associated with the replay. 

The use of the control functions (e.g., pause a replay) will be reflected in the telemetry data that 
is displayed on any connected dynamic pages. 

A.2.4 Document Reader 

A.2.4.1 Document Reader Usage 

The Document Reader is used to display on-line documentation, including user guides, 
operational procedures, and spacecraft and instrument technical documents. 
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Figure A.2.4-1. Document Reader 

A.2.4.2 Document Reader Access 

The Document Reader is invoked from the Tools Selector window, that is brought up off the 
Control window. 

A.2.4.3 Document Reader Input 

This will depend upon the COTS product which will be an HTML Browser. The window will 
contain such features as: a home button that will take the user to a menu; a scrollbar to view the 
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text; save text to a file; print text; traverse forward and backward; and hypertext capabilities 
where related subjects that are highlighted can be clicked upon to bring up information about the 
particular subject. 

A.2.4.4 Document Reader Output 

On-line browsing, and the printing of a document are the output. 

A.2.5 Display Builder 
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Figure A.2.5-1. Display Builder Palette Window�

File Name 

Label1 Label2 

Parameter1 UUU ########## LLDQ 

Parameter2 ########## 

Parameter4 ########## UUU 

########## LLDQ 

Graph1 Table1 

DAS 

Upconverter 

Figure A.2.5-2. Display Builder Window (after drop)�
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File Name 

Label1 Display Values 

Parameter1 UUU ########## LLDQ 

Parameter2 ########## 

Parameter4 ########## UUU 

########## LLDQ 

Graph1 Table1 

DAS 

Upconverter 

Figure A.2.5-3. Display Builder Window (after format changes)�
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Figure A.2.5-4. Data Source Dialog�
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Figure A.2.5-5. Field Format Dialog�
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Figure A.2.5-6. Separator Format Dialog�
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Figure A.2.5-7. Label Format Dialog�
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Figure A.2.5-8. Graph Format Dialog�
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Figure A.2.5-9. Table Format Dialog�
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Figure A.2.5-10. Rectangle Format Dialog�
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Figure A.2.5-16. Arc Format Dialog�
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A.2.5.1 Display Builder Usage 

The Display Builder is brought up from the tools button on the command window. A palette 
window and a drawing area, representing a dynamic page, will be displayed. The user can drag 
and drop display items from the palette to the dynamic page. Items such as labels, separators, 
fields, graphs, tables, and schematic display items: rectangles, squares, ellipses, circles, open and 
closed polygons, lines, arcs, points, and icons can become part of the dynamic page. Fields, 
graphs, tables, and schematic display items may be attached to a data source. The user presses a 
format button to invoke a format window that enables display items to be updated. From the 
format window, those items that are attached to a data source can then be attached to a subsystem 
and parameter in order for the user to visualize real-time spacecraft activity. The dynamic page is 
written to a file once the build button has been pressed on the Palette window. The file will be 
sent to Data Management for storage. It can be retrieved at any time for viewing. 

Release A3 will include the design for labels, separators, fields, graphs, and tables, while release 
B2 will include the schematic display items. 

A.2.5.2 Display Builder Access 

The Display Builder is brought up from the Tools window which is started from the Command 
Control window. 

A.2.5.3 Display Builder Input 

Display Builder Palette Window (Figure A.2.5-1): 

File: 

This is a pull-down menu that displays the following menu items: Open, New, Save, 
Save As, Print, and Quit. 

Open: 

This option invokes a File Selection dialog from which the user may select a 
dynamic page file to open in the Display Builder. 

Save: 

This option invokes a dialog from which the user may save the dynamic page as 
a file to the local drive. 

Save As: 

This option invokes a dialog from which the user may save the dynamic page as 
a file to the local drive under a different name other than the current file name. 

Print: 

This option allows the user to print the dynamic page. 

Quit: 

This option quits the Display Builder. 
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Edit: 

This is a pull-down menu that displays the following options: Cut, Copy, Paste, 
Delete, and Undo. 

Cut: 

This option will delete the highlighted display item, but place it in a buffer so 
that it can be pasted if needed. 

Copy: 

This option copies the highlighted display item into the buffer so that it can be 
pasted if needed. 

Paste: 

This option pastes whatever is in the buffer to the dynamic page. 

Delete: 

This option deletes a highlighted display item the same as the delete button on 
the Palette window. 

Undo: 

This option undoes the last action that the user performed. 

Utility: 

This is a pull-down menu that displays the following option: Grid. 

Grid: 

This button invokes will draw a grid on the dynamic page area for more precise 
placement of a display item. It can also be removed. This feature will not be 
implemented in release A. 

Help: 

This option displays help information about the Display Builder. 

Display Item: 

Under "Display Item", the user may drag and drop display items off each of the buttons. 
These include: Field Separator (vertical), Separator (horizontal), Label, Graph, Table. 

To drag and drop a display item, the user should keep the mouse button depressed after 
pressing on the desired button. The cursor icon will change. The user will move the 
cursor to the desired portion of the dynamic page, and let go of the mouse button. The 
cursor will revert to its original state, and the display item will be visible on the dynamic 
page with its surrounding borders highlighted. 

Schematic Display Item: 

Under "Schematic Display Item", the user may drag and drop only off the Icons' button. 
The rest of the buttons for Rectangle, Square, Ellipse, Circle, Polygon, Line, Arc, and 

A-42 605-CD-003-001




Point may be depressed in the usual manner. The user then draws the schematic display 
item to the desired size, after which the item's borders become highlighted. 

Action: 

Format: 

The format button is used to display the format windows for the display items. 
The user may update the display item's attributes, and in some cases, the 
subsystem and parameters. 

Delete: 

The display item that is highlighted can be deleted by pressing this button. 

Data Source: 

Display items such as field, graph, table, and schematic display items can be 
attached to a data source or logical string in order to connect to a spacecraft part 
in real-time. By pressing this button to invoke the Data Source dialog, the user 
can set up one or more logical strings. However, only one data source can be 
active at a time. 

Build to CM: 

This button may pressed after all of the display items have been dropped and 
formatted. A file will be written containing the dynamic page information. It will be 
copied to a Configuration Management directory under the auspices of Data 
Management. It may be retrieved at any time for viewing. 

Build to Local: 

This button may pressed after all of the display items have been dropped and 
formatted. A file will be written containing the dynamic page information. It will be 
sent to Data Management for storage. It may be retrieved at any time for viewing. 

Cancel: 

This button cancels any processing of the dynamic page, and exits the Display Builder. 

Display Builder Window (after drop) (Figure A.2.5-2): 

Drawing Area/Dynamic Page: 

Any display item from the Display Builder Palette window can be dropped, or drawn 
and displayed in the drawing area that represents the dynamic page. Once a display 
item has been dropped or drawn, it will be surrounded by a bounding box (rectangle, 
for tables, graphs, labels, fields, and separators only), and highlighted as the active 
display item. While only one display item can be highlighted, the example in the 
referenced figure shows "Label2" is an active display item, and a circle as an active 
schematic display item in order to explain the changes performed upon them by 
updating their format windows. 

Numbering Scheme: 
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Each time a display item that contains text is dropped, a unique identifying number 
will be attached to the text. For example, if a label is dropped, it will be called 
"Label1". A second dropped label will be called "Label2", and the third will be 
"Label3". If "Label2" is then deleted, and a new label is dropped, the new label will 
read "Label2". 

Movement: 

When a display item is clicked upon, it will become highlighted. Any highlighted 
display item can be moved about the dynamic page by clicking on the highlighted 
bounding box a second time. When the user holds down the mouse button, the cursor 
will change to a crosshair, and a box will appear. Drag the box to the desired location, 
and release the mouse button. The highlighted display item will appear at its new 
location, and it will be erased from its old location. 

Resizing: 

Resizing, if allowed, can be accomplished by placing the cursor over the highlighted 
portion of the active display item. The cursor arrow will change to the direction the 
resize will go if the user presses that area of the bounding box. Resizing is achieved 
by holding down the mouse button and dragging it in the allowed direction. The 
bounding box will stretch or shrink according to the direction of the mouse. Release 
the mouse button when the desired size is achieved. This method is called rubber­
banding. Once finished, the highlighted display item will be re-drawn at its new size, 
and the old size will be deleted. The following describes the resize movements 
allowed by the display items. 

Labels: 

Labels may not be resized from the Display Builder window because the length 
of the label is fixed, and determines the size of the item as well as the 
highlighted bounding box. 

Vertical separators: 

Vertical separators may be enlarged or made smaller only from the top and 
bottom of the separator. 

Horizontal separators: 

Horizontal separators may be enlarged or made smaller only from the left and 
right sides of the separator. 

Field: 

A field may not be resized from the Display Builder window because the length 
of each portion that comprises a field is fixed, and determines the size of the 
item as well as the highlighted bounding box. 

Graph: 

A graph may be resized in any direction. 
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Table: 

A table may be resized in any direction. 

Rectangle, Square, Ellipse, Circle, Open Polygon, Closed Polygon, Arc: 

These schematic display items may be resized in any direction. 

Line: 

A line may be resized in any direction at its endpoints. 

Point: 

A point may not be resized, otherwise it would become a filled circle. 

Icons: 

An icon may not be resized because it is a pixmap, which is a fixed size. 

Display Builder Window (after format changes) (Figure A.2.5-3): 

Drawing Area/Dynamic Page: 

This is the same screen as Figure A.2.5-2 except that: 

1.	  formatting for "Label2" has taken place. The user has changed the value of the 
text in the Label Format window to read "Display Values". The Display Builder 
window now shows the update from that label text change. 

2. 	 formatting for the circle has taken place. The user has changed the circle to a 
"filling" circle, and applied a parameter's analog values to it. The Display Builder 
window now shows the update from that circle update. 

Data Source Dialog (Figure A.2.5-4): 

This dialog is used to build and display data sources, or logical strings that can be 
connected to display items. Note: if * is used for the default, then the best guess will 
be used to connect to a logical string at the time the dynamic page is viewed in its 
operational stage. 

Vehicle: 

Option menu that displays the spacecrafts. Can be set to AM1, PM1, or * for 
default. 

Mode: 

Option menu that displays various modes. Can be set to Operational, Test, 
Training, or * for default. 

Data Source: 

Option menu that displays various data sources. Can be set to Real-time, 
Replay, Simulation, or * for default. 

Create: 
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This button is pressed once the Vehicle, Mode, and Data Source have been 
selected. The combined selection will appear highlighted in the scrolling 
window. 

Delete: 

This button will delete the highlighted data source in the scrolling window. 

OK: 

This button will save the data sources that have been created. Only the 
highlighted data source will be the active data source at the time. Then the 
window is deleted. 

Cancel: 

This button will quit the dialog with no updates. 

Help: 

This button invokes a display that gives help information about the Data Source 
dialog. 

Field Format Dialog (Figure A.2.5-5): 

This dialog is used to update the attributes, content, and parameter of a field. 

X Position: 

The upper left x coordinate of the field bounding box will be pre-filled, and can be 
updated by the user. 

Y Position: 

The upper left y coordinate of the field bounding box will be pre-filled, and can be 
updated by the user. 

Value Types (Data): 

From this radio box, only one choice may be selected for a value portion of a field: 
Converted, Decoded, Raw. 

Value Types (Display): 

From this radio box, only one choice may be selected for a value portion of a field: 
Formatted, Hex, Octal, Binary. 

Available Fields: 

The buttons: FieldLabel, Unit, Flags, and Value allow the user to drag a portion of the 
field, and drop it in the Selected Fields area. In this manner the components of the 
field may be moved in any combination, and are optional. However, Value is 
required, and will be displayed in the Selected Fields portion of the screen at all 
times (its order in the chain may be rearranged). 

Selected Fields: 
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The buttons: FieldLabel, Unit, Flags, and Value represent the components of the field, 
and the order in which they will show up on the dynamic page. A component may be 
dragged and dropped back to its same component button in the Available fields are in 
order to be deleted from the Selected Fields portion of the screen. Only Value may 
not be dragged and dropped to its Available Fields button because it is the 
required portion of a field. 

Data Source: 

The data source that was highlighted in the Data Source dialog will be pre-filled here. 
It can be updated from the Data Source dialog. 

Data Source (Select): 

This button invokes the Data Source dialog from which the user may change the data 
source. 

Subsystem: 

The subsystem filter selector can be executed to select a subsystem. 

Filter: 

This button will bring up the Selection Filter window. 

All: 

This button selects all the subsystems. 

Available Parameters: 

Find: 

The user inputs text into this area, and a search is performed for that text in the 
Available Parameters window. 

All->: 

This button will be shaded out as only one parameter may be selected at a time. 

->: 

This button moves the selected parameter to the Selected Parameters window. 
Selected Parameters: 

<-: 

This button moves the selected parameter back to the Available Parameters 
window. 

<-All: 

This button moves the selected parameter back to the Available Parameters 
window. 

OK: 

This button processes the changes from the dialog, and quits it. 
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Cancel: 

This button quits the dialog without any updates. 

Help: 

This button invokes a display that gives help information about the Field Format 
dialog. 

Separator Format Dialog (Figure A.2.5-6): 

This dialog is used to update the position and attributes of a separator. 

X Position: 

The upper left x coordinate of the separator bounding box will be pre-filled, and can 
be updated by the user. 

Y Position: 

The upper left y coordinate of the separator bounding box will be pre-filled, and can 
be updated by the user. 

Length: 

The length of the separator will be pre-filled, and can be updated by the user. 

Orientation: 

The orientation of the separator will be pre-filled to either horizontal, or vertical, 
and can be updated by the user. 

Color: 

This button brings up a color dialog from which the user may change the color 
of the separator. 

OK: 

This button processes the changes from the dialog, and quits it. 

Cancel: 

This button quits the dialog without any updates. 

Help: 

This button invokes a display that gives help information about the Separator Format 
dialog. 
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Label Format Dialog (Figure A.2.5-7): 

This dialog is used to update the position and attributes of a label. 

X Position: 

The x coordinate of the label's highlighted bounding box will be pre-filled, and can be 
updated by the user. 

Y Position: 

The y coordinate of the label's highlighted bounding box will be pre-filled, and can be 
updated by the user. 

Text: 

The text of the label will be pre-filled the first time with "Label" and the identifying 
number of the label. The text can be updated by the user. 

Color: 

This button brings up a color dialog from which the user may change the color of the 
label. 

OK: 

This button processes the changes from the dialog, and quits it. 

Cancel: 

This button quits the dialog without any updates. 

Help: 

This button invokes a display that gives help information about the Label Format 
dialog. 

Graph Format Dialog (Figure A.2.5-8): 

This dialog is used to update the attributes, content, and parameters of a graph. 

X Position: 

The upper left x coordinate of the graph highlighted bounding box will be pre-filled, 
and can be updated by the user. 

Y Position: 

The upper left y coordinate of the graph highlighted bounding box will be pre-filled, 
and can be updated by the user. 

Width: 

The width of the graph highlighted bounding box will be pre-filled, and can be 
updated by the user. 

Height: 
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The height of the graph highlighted bounding box will be pre-filled, and can be 
updated by the user. 

Graph Format: 

The Graph Format dialog widget will appear here from which the user may change 
attributes about the graph. 

Subsystem: 

The subsystem filter selector can be executed to select a subsystem. 

Filter: 

This button will bring up the Selection Filter window. 

All: 

This button selects all the subsystems. 

Available Parameters: 

Find: 

The user inputs text into this area, and a search is performed for that text in the 
Available Parameters window. 

All->: 

This button will be shaded out as only one parameter may be selected at a time. 

->: 

This button moves the selected parameter to the Selected Parameters window. 

Selected Parameters: 

<-: 

This button moves the selected parameter back to the Available Parameters 
window. 

<-All: 

This button moves the selected parameter back to the Available Parameters 
window. 

OK: 

This button processes the changes from the dialog, and quits it. 

Cancel: 

This button quits the dialog without any updates. 

Help: 

This button invokes a display that gives help information about the Graph Format 
dialog. 
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Table Format Dialog (Figure A.2.5-9): 

This dialog is used to update the attributes, content, and parameters of a table. 

X Position: 

The upper left x coordinate of the table highlighted bounding box will be pre-filled, 
and can be updated by the user. 

Y Position: 

The upper left y coordinate of the table highlighted bounding box will be pre-filled, 
and can be updated by the user. 

Width: 

The width of the table highlighted bounding box will be pre-filled, and can be 
updated by the user. 

Height: 

The height of the table highlighted bounding box will be pre-filled, and can be 
updated by the user. 

Table Format: 

The Table Format dialog widget will appear here from which the user may change 
attributes about the table. 

Subsystem: 

The subsystem filter selector can be executed to select a subsystem. 

Filter: 

This button will bring up the Selection Filter window. 

All: 

This button selects all the subsystems. 

Available Parameters: 

Find: 

The user inputs text into this area, and a search is performed for that text in the 
Available Parameters window. 

All->: 

This button will be shaded out as only one parameter may be selected at a time. 

->: 

This button moves the selected parameter to the Selected Parameters window. 

Selected Parameters: 

<-: 
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This button moves the selected parameter back to the Available Parameters 
window. 

<-All: 

This button moves the selected parameter back to the Available Parameters 
window. 

OK: 

This button processes the changes from the dialog, and quits it. 

Cancel: 

This button quits the dialog without any updates. 

Help: 

This button invokes a display that gives help information about the Table 
Format dialog. 

Rectangle Format Dialog (Figure A.2.5-10): 

This dialog is used to update the attributes and parameters of a rectangle. 

X Position: 

The upper left x coordinate of the rectangle's highlighted bounding box will be pre­
filled, and can be updated by the user. 

Y Position: 

The upper left y coordinate of the rectangle's highlighted bounding box will be pre­
filled, and can be updated by the user. 

Width: 

The width of the rectangle's highlighted bounding box will be pre-filled, and can be 
updated by the user. 

Height: 

The height of the rectangle's highlighted bounding box will be pre-filled, and can be 
updated by the user. 

Line Thickness: 

The line thickness of the rectangle will be pre-filled, and can be updated by the user. 

Line Style: 

Solid: 

The line style of the rectangle will default to "Solid". A line will be drawn using 
the foreground color. 

OnOff Dash: 

This selection specifies that only dashes are drawn with the foreground color. 
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Double Dash: 

This selection specifies that the full path of a line is drawn with the foreground 
color while are drawn gaps with the background color. 

Fill Style: 

Not Filled: 

The fill style of the rectangle will default to "Not Filled". A rectangle's borders 
will be drawn with no fill color. 

Filled: 

A rectangle's borders and interior will be filled with a specified color. 

Filling: 

A rectangle may be attached to an analog parameter's values. The "Filling" 
selection allows the start and stop range values to pop up. The rectangle will 
begin as "Not Filled" when at the start range, and will proportionally fill itself 
with a specified color, until it is filled at the stop range. 

Range: 

This portion of the display will only appear if "Filling" is selected. 

Empty: 

The empty value relating to the analog parameter will be pre-filled to 
the low yellow value, and can be updated by the user. 

Full: 

The full value relating to the analog parameter will be pre-filled to the 
high yellow value, and can be updated by the user. 

View Ranges: 

This portion of the display will only appear if "Filling" is selected. When 
the user presses this button, a dialog will appear from which the ranges of 
the parameter (i.e. high red, high yellow, low yellow, and low red) may be 
viewed. 

Color: 

A color dialog is invoked with this selection. The color chosen will act as the 
foreground color of the schematic display item. This color will be overridden if 
the display item is attached to a parameter. 

Data Source: 

The data source that was highlighted in the Data Source dialog will be pre-filled here. 
It can be updated from the Data Source dialog. 

Data Source (Select): 
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This button invokes the Data Source dialog from which the user may change the data 
source. 

Subsystem: 

The subsystem filter selector can be executed to select a subsystem. 

Filter: 

This button will bring up the Selection Filter window. 

All: 

This button selects all the subsystems. 

Available Parameters: 

Find: 

The user inputs text into this area, and a search is performed for that text in the 
Available Parameters window. 

All->: 

This button will be shaded out as only one parameter may be selected at a time. 

->: 

This button moves the selected parameter to the Selected Parameters window. 

Selected Parameters: 

<-: 

This button moves the selected parameter back to the Available Parameters 
window. 

<-All: 

This button moves the selected parameter back to the Available Parameters 
window. 

OK: 

This button processes the changes from the dialog, and quits it. 

Cancel: 

This button quits the dialog without any updates. 

Help: 

This button invokes a display that gives help information about the Rectangle Format 
dialog. 

Square Format Dialog (Figure A.2.5-11): 

This dialog is used to update the attributes and parameters of a square. 

X Position: 
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The upper left x coordinate of the square's highlighted bounding box will be pre­
filled, and can be updated by the user. 

Y Position: 

The upper left y coordinate of the square's highlighted bounding box will be pre­
filled, and can be updated by the user. 

Width: 

The width of the square's highlighted bounding box will be pre-filled, and can be 
updated by the user. 

Height: 

The height of the square's highlighted bounding box will be pre-filled, and can be 
updated by the user. 

Line Thickness: 

The line thickness of the square will be pre-filled, and can be updated by the user. 

Line Style: 

Solid: 

The line style of the square will default to "Solid". A line will be drawn 
using the foreground color. 

OnOff Dash: 

This selection specifies that only dashes are drawn with the foreground 
color. 

Double Dash: 

This selection specifies that the full path of a line is drawn with the 
foreground color while are drawn gaps with the background color. 

Fill Style: 

Not Filled: 

The fill style of the square will default to "Not Filled". A rectangle's borders will 
be drawn with no fill color. 

Filled: 

A square's borders and interior will be filled with a specified color. 

Filling: 

A square may be attached to an analog parameter's values. The "Filling" 
selection allows the start and stop range values to pop up. The square will begin 
as "Not Filled" when at the start range, and will proportionally fill itself with a 
specified color, until it is filled at the stop range. 

Range: 
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This portion of the display will only appear if "Filling" is selected. 

Empty: 

The empty value relating to the analog parameter will be pre-filled to 
the low yellow value, and can be updated by the user. 

Full: 

The full value relating to the analog parameter will be pre-filled to the 
high yellow value, and can be updated by the user. 

View Ranges: 

This portion of the display will only appear if "Filling" is selected. When 
the user presses this button, a dialog will appear from which the ranges of 
the parameter (i.e. high red, high yellow, low yellow, and low red) may be 
viewed. 

Color: 

A color dialog is invoked with this selection. The color chosen will act as the 
foreground color of the schematic display item. This color will be overridden if the 
display item is attached to a parameter. 

Data Source: 

The data source that was highlighted in the Data Source dialog will be pre-filled here. 
It can be updated from the Data Source dialog. 

Data Source (Select): 

This button invokes the Data Source dialog from which the user may change the data 
source. 

Subsystem: 

The subsystem filter selector can be executed to select a subsystem. 

Filter: 

This button will bring up the Selection Filter window. 

All: 

This button selects all the subsystems. 

Available Parameters: 

Find: 

The user inputs text into this area, and a search is performed for that text in the 
Available Parameters window. 

All->: 

This button will be shaded out as only one parameter may be selected at a time. 
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->: 

This button moves the selected parameter to the Selected Parameters window. 

Selected Parameters: 

<-: 

This button moves the selected parameter back to the Available Parameters 
window. 

<-All: 

This button moves the selected parameter back to the Available Parameters 
window. 

OK: 

This button processes the changes from the dialog, and quits it. 

Cancel: 

This button quits the dialog without any updates. 

Help: 

This button invokes a display that gives help information about the Square Format 
dialog. 

Ellipse Format Dialog (Figure A.2.5-12): 

This dialog is used to update the attributes and parameters of an ellipse. 

X Position: 

The upper left x coordinate of the ellipse's highlighted bounding box will be pre­
filled, and can be updated by the user. 

Y Position: 

The upper left y coordinate of the ellipse's highlighted bounding box will be pre­
filled, and can be updated by the user. 

Width: 

The width of the ellipse's highlighted bounding box will be pre-filled, and can be 
updated by the user. 

Height: 

The height of the ellipse's highlighted bounding box will be pre-filled, and can be 
updated by the user. 

Line Thickness: 

The line thickness of the ellipse will be pre-filled, and can be updated by the user. 

Line Style: 
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Solid: 

The line style of the ellipse will default to "Solid". A line will be drawn using 
the foreground color. 

OnOff Dash: 

This selection specifies that only dashes are drawn with the foreground color. 

Double Dash: 

This selection specifies that the full path of a line is drawn with the foreground 
color while are drawn gaps with the background color. 

Fill Style: 

Not Filled: 

The fill style of the ellipse will default to "Not Filled". A rectangle's borders will 
be drawn with no fill color. 

Filled: 

A ellipse's borders and interior will be filled with a specified color. 

Filling: 

A ellipse may be attached to an analog parameter's values. The "Filling" 
selection allows the start and stop range values to pop up. The ellipse will begin 
as "Not Filled" when at the start range, and will proportionally fill itself with a 
specified color, until it is filled at the stop range. 

Range: 

This portion of the display will only appear if "Filling" is selected. 

Empty: 

The empty value relating to the analog parameter will be pre-filled to 
the low yellow value, and can be updated by the user. 

Full: 

The full value relating to the analog parameter will be pre-filled to the 
high yellow value, and can be updated by the user. 

View Ranges: 

This portion of the display will only appear if "Filling" is selected. When 
the user presses this button, a dialog will appear from which the ranges of 
the parameter (i.e. high red, high yellow, low yellow, and low red) may be 
viewed. 
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Color: 

A color dialog is invoked with this selection. The color chosen will act as the 
foreground color of the schematic display item. This color will be overridden if the 
display item is attached to a parameter. 

Data Source: 

The data source that was highlighted in the Data Source dialog will be pre-filled here. 
It can be updated from the Data Source dialog. 

Data Source (Select): 

This button invokes the Data Source dialog from which the user may change the data 
source. 

Subsystem: 

The subsystem filter selector can be executed to select a subsystem. 

Filter: 

This button will bring up the Selection Filter window. 

All: 

This button selects all the subsystems. 

Available Parameters: 

Find: 

The user inputs text into this area, and a search is performed for that text in the 
Available Parameters window. 

All->: 

This button will be shaded out as only one parameter may be selected at a time. 

->: 

This button moves the selected parameter to the Selected Parameters window. 

Selected Parameters: 

<-: 

This button moves the selected parameter back to the Available Parameters 
window. 

<-All: 

This button moves the selected parameter back to the Available Parameters 
window. 

OK: 

This button processes the changes from the dialog, and quits it. 
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Cancel: 

This button quits the dialog without any updates. 

Help: 

This button invokes a display that gives help information about the Ellipse Format 
dialog. 

Circle Format Dialog (Figure A.2.5-13): 

This dialog is used to update the attributes and parameters of a circle. 

X Position: 

The upper left x coordinate of the circle's highlighted bounding box will be pre-filled, 
and can be updated by the user. 

Y Position: 

The upper left y coordinate of the circle's highlighted bounding box will be pre-filled, 
and can be updated by the user. 

Width: 

The width of the circle's highlighted bounding box will be pre-filled, and can be 
updated by the user. 

Height: 

The height of the circle's highlighted bounding box will be pre-filled, and can be 
updated by the user. 

Line Thickness: 

The line thickness of the circle will be pre-filled, and can be updated by the user. 

Line Style: 

Solid: 

The line style of the circle will default to "Solid". A line will be drawn using the 
foreground color. 

OnOff Dash: 

This selection specifies that only dashes are drawn with the foreground 
color. 

Double Dash: 

This selection specifies that the full path of a line is drawn with the 
foreground color while are drawn gaps with the background color. 

Fill Style: 

Not Filled: 
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The fill style of the circle will default to "Not Filled". A rectangle's borders will 
be drawn with no fill color. 

Filled: 

A circle's borders and interior will be filled with a specified color. 

Filling: 

A circle may be attached to an analog parameter's values. The "Filling" selection 
allows the start and stop range values to pop up. The circle will begin as "Not 
Filled" when at the start range, and will proportionally fill itself with a specified 
color, until it is filled at the stop range. 

Range: 

This portion of the display will only appear if "Filling" is selected. 

Empty: 

The empty value relating to the analog parameter will be pre-filled to 
the low yellow value, and can be updated by the user. 

Full: 

The full value relating to the analog parameter will be pre-filled to the 
high yellow value, and can be updated by the user. 

View Ranges: 

This portion of the display will only appear if "Filling" is selected. When 
the user presses this button, a dialog will appear from which the ranges of 
the parameter (i.e. high red, high yellow, low yellow, and low red) may be 
viewed. 

Color: 

A color dialog is invoked with this selection. The color chosen will act as the 
foreground color of the schematic display item. This color will be overridden if the 
display item is attached to a parameter. 

Data Source: 

The data source that was highlighted in the Data Source dialog will be pre-filled here. 
It can be updated from the Data Source dialog. 

Data Source (Select): 

This button invokes the Data Source dialog from which the user may change the data 
source. 

Subsystem: 

The subsystem filter selector can be executed to select a subsystem. 

Filter: 
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This button will bring up the Selection Filter window. 

All: 

This button selects all the subsystems. 

Available Parameters: 

Find: 

The user inputs text into this area, and a search is performed for that text in the 
Available Parameters window. 

All->: 

This button will be shaded out as only one parameter may be selected at a time. 

->: 

This button moves the selected parameter to the Selected Parameters window. 

Selected Parameters: 

<-: 

This button moves the selected parameter back to the Available Parameters 
window. 

<-All: 

This button moves the selected parameter back to the Available Parameters 
window. 

OK: 

This button processes the changes from the dialog, and quits it. 

Cancel: 

This button quits the dialog without any updates. 

Help: 

This button invokes a display that gives help information about the Circle Format 
dialog. 

Polygon Format Dialog (Figure A.2.5-14): 

This dialog is used to update the attributes and parameters of a polygon. 

X Position: 

The upper left x coordinate of the polygon's highlighted bounding box will be pre­
filled, and can be updated by the user. 

Y Position: 

The upper left y coordinate of the polygon's highlighted bounding box will be pre­
filled, and can be updated by the user. 
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Width: 

The width of the polygon's highlighted bounding box will be pre-filled, and can be 
updated by the user. 

Height: 

The height of the polygon's highlighted bounding box will be pre-filled, and can be 
updated by the user. 

Line Thickness: 

The line thickness of the polygon will be pre-filled, and can be updated by the user. 
Line Style: 

Solid: 

The line style of the polygon will default to "Solid". A line will be drawn using 
the foreground color. 

OnOff Dash: 

This selection specifies that only dashes are drawn with the foreground color. 

Double Dash: 

This selection specifies that the full path of a line is drawn with the foreground 
color while are drawn gaps with the background color. 

Fill Style: 

Not Filled: 

The fill style of the polygon will default to "Not Filled". A rectangle's 
borders will be drawn with no fill color. 

Filled: 

A polygon's borders and interior will be filled with a specified color. 

Status: 

The status of the polygon will be pre-filled to either opened, or closed depending on 
how the user drew the polygon. 

Closed: 

If the status of the polygon was previously set to "Opened", then a line would be 
drawn across the two open ended points to close the polygon. 

Open: 

If the status of the polygon was previously set to "Closed", then a line would be 
erased across the first and the last points of the polygon. 

Color: 
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A color dialog is invoked with this selection. The color chosen will act as the 
foreground color of the schematic display item. This color will be overridden if the 
display item is attached to a parameter. 

Data Source: 

The data source that was highlighted in the Data Source dialog will be pre-filled here. 
It can be updated from the Data Source dialog. 

Data Source (Select): 

This button invokes the Data Source dialog from which the user may change the data 
source. 

Subsystem: 

The subsystem filter selector can be executed to select a subsystem. 

Filter: 

This button will bring up the Selection Filter window. 

All: 

This button selects all the subsystems. 

Available Parameters: 

Find: 

The user inputs text into this area, and a search is performed for that text in the 
Available 

Parameters window. 

All->: 

This button will be shaded out as only one parameter may be selected at a time. 

->: 

This button moves the selected parameter to the Selected Parameters window. 

Selected Parameters: 

<-: 

This button moves the selected parameter back to the Available Parameters 
window. 

<-All: 

This button moves the selected parameter back to the Available Parameters 
window. 

OK: 

This button processes the changes from the dialog, and quits it. 

A-64 605-CD-003-001




Cancel: 

This button quits the dialog without any updates. 

Help: 

This button invokes a display that gives help information about the Polygon Format 
dialog. 

Line Format Dialog (Figure A.2.5-15): 

This dialog is used to update the attributes and parameters of a line. 

X Position: 

The upper left x coordinate of the line's highlighted bounding box will be pre-filled, 
and can be updated by the user. 

Y Position: 

The upper left y coordinate of the line's highlighted bounding box will be pre-filled, 
and can be updated by the user. 

Width: 

The width of the line's highlighted bounding box will be pre-filled, and can be 
updated by the user. 

Height: 

The height of the line's highlighted bounding box will be pre-filled, and can be 
updated by the user. 

Line Thickness: 

The line thickness of the line will be pre-filled, and can be updated by the user. 

Line Style: 

Solid: 

The line style of the line will default to "Solid". A line will be drawn using the 
foreground color. 

OnOff Dash: 

This selection specifies that only dashes are drawn with the foreground color. 

Double Dash: 

This selection specifies that the full path of a line is drawn with the foreground 
color while are drawn gaps with the background color. 

Color: 

A color dialog is invoked with this selection. The color chosen will act as the 
foreground color of the schematic display item. This color will be overridden if the 
display item is attached to a parameter. 
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Data Source: 

The data source that was highlighted in the Data Source dialog will be pre-filled here. 
It can be updated from the Data Source dialog. 

Data Source (Select): 

This button invokes the Data Source dialog from which the user may change the data 
source. 

Subsystem: 

The subsystem filter selector can be executed to select a subsystem. 

Filter: 

This button will bring up the Selection Filter window. 

All: 

This button selects all the subsystems. 

Available Parameters: 

Find: 

The user inputs text into this area, and a search is performed for that text in the 
Available Parameters window. 

All->: 

This button will be shaded out as only one parameter may be selected at a time. 

->: 

This button moves the selected parameter to the Selected Parameters window. 

Selected Parameters: 

<-: 

This button moves the selected parameter back to the Available Parameters 
window. 

<-All: 

This button moves the selected parameter back to the Available Parameters 
window. 

OK: 

This button processes the changes from the dialog, and quits it. 

Cancel: 

This button quits the dialog without any updates. 

Help: 
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This button invokes a display that gives help information about the Line Format 
dialog. 

Arc Format Dialog (Figure A.2.5-16): 

This dialog is used to update the attributes and parameters of an arc. 

X Position: 

The upper left x coordinate of the arc's highlighted bounding box will be pre-filled, 
and can be updated by the user. 

Y Position: 

The upper left y coordinate of the arc's highlighted bounding box will be pre-filled, 
and can be updated by the user. 

Width: 

The width of the arc's highlighted bounding box will be pre-filled, and can be updated 
by the user. 

Height: 

The height of the arc's highlighted bounding box will be pre-filled, and can be 
updated by the user. 

Line Thickness: 

The line thickness of the arc will be pre-filled, and can be updated by the user. 

Line Style: 

Solid: 

The line style of the arc will default to "Solid". A line will be drawn using the 
foreground color. 

OnOff Dash: 

This selection specifies that only dashes are drawn with the foreground color. 

Double Dash: 

This selection specifies that the full path of a line is drawn with the foreground 
color while are drawn gaps with the background color. 

Color: 

A color dialog is invoked with this selection. The color chosen will act as the 
foreground color of the schematic display item. This color will be overridden if the 
display item is attached to a parameter. 

Data Source: 

The data source that was highlighted in the Data Source dialog will be pre-filled here. 
It can be updated from the Data Source dialog. 
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Data Source (Select): 

This button invokes the Data Source dialog from which the user may change the data 
source. 

Subsystem: 

The subsystem filter selector can be executed to select a subsystem. 

Filter: 

This button will bring up the Selection Filter window. 

All: 

This button selects all the subsystems. 

Available Parameters: 

Find: 

The user inputs text into this area, and a search is performed for that text in the 
Available Parameters window. 

All->: 

This button will be shaded out as only one parameter may be selected at a time. 

->: 

This button moves the selected parameter to the Selected Parameters window. 

Selected Parameters: 

<-: 

This button moves the selected parameter back to the Available Parameters 
window. 

<-All: 

This button moves the selected parameter back to the Available Parameters 
window. 

OK: 

This button processes the changes from the dialog, and quits it. 

Cancel: 

This button quits the dialog without any updates. 

Help: 

This button invokes a display that gives help information about the Arc Format 
dialog. 

Point Format Dialog (Figure A.2.5-17): 

This dialog is used to update the attributes and parameters of a point. 
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X Position: 

The upper left x coordinate of the point's highlighted bounding box will be pre-filled, 
and can be updated by the user. 

Y Position: 

The upper left y coordinate of the point's highlighted bounding box will be pre-filled, 
and can be updated by the user. 

Color: 

A color dialog is invoked with this selection. The color chosen will act as the 
foreground color of the schematic display item. This color will be overridden if the 
display item is attached to a parameter. 

Data Source: 

The data source that was highlighted in the Data Source dialog will be pre-filled here. 
It can be updated from the Data Source dialog. 

Data Source (Select): 

This button invokes the Data Source dialog from which the user may change the data 
source. 

Subsystem: 

The subsystem filter selector can be executed to select a subsystem. 

Filter: 

This button will bring up the Selection Filter window. 

All: 

This button selects all the subsystems. 

Available Parameters: 

Find: 

The user inputs text into this area, and a search is performed for that text in the 
Available Parameters window. 

All->: 

This button will be shaded out as only one parameter may be selected at a time. 

->: 

This button moves the selected parameter to the Selected Parameters window. 

Selected Parameters: 

<-: 

This button moves the selected parameter back to the Available Parameters 
window. 
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<-All: 

This button moves the selected parameter back to the Available Parameters 
window. 

OK: 

This button processes the changes from the dialog, and quits it. 

Cancel: 

This button quits the dialog without any updates. 

Help: 

This button invokes a display that gives help information about the Point Format 
dialog. 

Icons Format Dialog (Figure A.2.5-18): 

This dialog is used to update the attributes and parameters of a point. 

X Position: 

The upper left x coordinate of the point's highlighted bounding box will be pre-filled, 
and can be updated by the user. 

Y Position: 

The upper left y coordinate of the point's highlighted bounding box will be pre-filled, 
and can be updated by the user. 

Select a Pair of Icons: 

The user may choose one pair of icons from which a discrete parameter's values may 
be attached. 

"Discrete Parameter" States: 

Once a discrete parameter has been chosen, its possible values will appear in the 
scrolling list window. The user may click on a value, and that state will be assigned to 
one of the selected icons. Similarly, a click on a second value will assign that state to 
the other icon in the pair. 

Data Source: 

The data source that was highlighted in the Data Source dialog will be pre-filled here. 
It can be updated from the Data Source dialog. 

Data Source (Select): 

This button invokes the Data Source dialog from which the user may change the data 
source. 

Subsystem: 

The subsystem filter selector can be executed to select a subsystem. 
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Filter: 

This button will bring up the selection Filter window. 

All: 

This button selects all the subsystems. 

Available Parameters: 

Find: 

The user inputs text into this area, and a search is performed for that text in the 
Available Parameters window. 

All->: 

This button will be shaded out as only one parameter may be selected at a time. 

->: 

This button moves the selected parameter to the Selected Parameters window. 

Selected Parameters: 

<-: 

This button moves the selected parameter back to the Available Parameters 
window. 

<-All: 

This button moves the selected parameter back to the Available Parameters 
window. 

OK: 

This button processes the changes from the dialog, and quits it. 

Cancel: 

This button quits the dialog without any updates. 

Help: 

This button invokes a display that gives help information about the Icons Format 
dialog. 

A.2.5.4 Display Builder Output 

When the Build button on the Display Builder Palette window is pressed, the dynamic page will 
be saved to a file. The file will be sent to Data Management for storage and retrieval. 
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A.2.6 Help Window 

Figure A.2.6-1. Help Window 
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A.2.6.1 Help Usage 

The help window is used to display context-sensitive help information from any FOS window. 
It will be implemented using a COTS product. 

A.2.6.2 Help Access 

Each window has a help button. When the button is pressed, the context-sensitive text for that 
window will be displayed in the help window. For example, when the quick analysis window's 
help button is pressed, the quick analysis help text will appear in the help window. 

A.2.6.3 Help Input 

This will depend upon the COTS product. The window will contain such features as: a home 
button that will take the user to a menu; a scrollbar to view the text; save text to a file; print text; 
traverse forward and backward; and hypertext capabilities where related subjects that are 
highlighted can be clicked upon to bring up information about the particular subject. 

A.2.6.4 Help Output 

The help window will display the help text for the window that called it. 
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A.2.7 Procedure Builder/Procedure Editor 

Procedure Editor 

Procedure: 

<<<Procedure Text>>> 

Loaded 36 lines (496 bytes) from cmdProcs/Fire_Thruster 

PASS PASSGo To: Check SyntaxValidate 

File Edit Tools Help 

Type: Command Fire_Thruster 

Figure A.2.7-1. Procedure Editor Window 

A.2.7.1 Procedure Editor Usage 

The Procedure Editor (Figure A.2.7-1) is used by the Flight Operations Team (FOT) and 
Instrument Operations Team (IOT) members to develop and maintain ECS Command Language 
(ECL) procedures. This tool allows a user to create, edit, delete, save, and print procedures. The 
edit and delete operations are subject to authorization checking. The Procedure Editor includes 
standard editing operations (e.g., cut, copy, paste, etc.) along with FOS-specific operations that 
allow the user to perform syntax checking (i.e., check the grammar) and validation (i.e., check 
command constraints). 
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The Procedure Editor includes a menu bar with four pull-down menus: File, Edit, Tools, and 
Help. Each of these menus is described in Section A.2.7.3 below. Just below the menu bar is an 
identification line. This line contains the name of the procedure and its type. Valid types include 
Emergency, Command, Ground, Local, Activity, and User-defined. A scrolling text window is 
located below the identification line. This window contains the procedure text entered by the 
user. Standard keyboard and mouse editing functions (e.g., Page Up, Page Down, highlighting 
with the mouse, etc.) are accommodated in this window. Under the text window is a status line 
The status line displays messages indicating the completion of user-activated operations (e.g., 
procedure loaded, syntax check completed, etc.). If an error occurs during an operation, the 
status message will provide information to assist the user in resolving the error. Along the 
bottom of the Procedure Editor window is a text input field and two buttons with associated 
status indicators. The text input field allows a user to enter either a line number or a label for the 
Go To operation. The buttons allow a user to validate the procedure or to check the syntax of the 
directives. The values displayed in the associated status indicators is described in Section 
A.2.7.4. 

A.2.7.2 Procedure Editor Access 

The Procedure Editor may be accessed from several windows, including: 

• The Control Window (two methods), 

• The Command Request Window, and 

• The Command Control Display. 

A user may access the Procedure Editor from the Control Window either through the Tools menu 
or the Proc menu. If the Procedure Editor is activated from the Tools menu, it will display a 
procedure template. If activated from the Proc menu, the editor will display the selected 
procedure. 

The Command Request Window, which provides the capability to create and submit command 
requests to the Command Activity Controller, allows a user to access the Procedure Editor via a 
push button. The Procedure Editor allows the requester to create, modify, or display procedures 
that can be attached to a command request. 

The Command Control Display allows a user with command authority to activate the procedure 
editor using a procedure selection dialog. This capability allows the user to create, edit, or 
display a procedure that can be merged in with the executing ground script directives. 

In addition to the access provided through the windows described above, the Procedure Editor 
may be activated via an ECL directive. A user may specify the name and type of the procedure 
in the directive. If a name is not specified, the procedure editor will be activated with a 
procedure template. 

A.2.7.3 Procedure Editor Input 

The Procedure Editor provides the user with standard editing capabilities through a combination 
of keyboard and mouse input. The keyboard is used primarily to enter procedure text. Support 
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for keyboard control keys (e.g., Page Up, Page Down, Home, End, etc.) is also provided. 
Accelerator keys are provided for both the menu bar and the pull-down menu options (e.g., 
<alt>F displays the File menu, <alt>X performs the cut operation). 

The mouse is used to position the cursor within the procedure text, to perform standard Motif 
selection operations (e.g., double-click selects the current word, triple-click select the current 
line, quadruple-click select all text), to select options from the menu bar and pull-down menus, 
and to select the Validate or Check Syntax buttons. The Procedure Editor menu bar contains 
four pull-down menus: File, Edit, Tools, and Help. The File menu options include: 

New opens a template file to create a new procedure. 

Open	 displays a file selection dialog window that allows the user to open an 
existing procedure. 

Save	 saves the current procedure, including its validation and syntax check 
indicators. By default, the procedure is saved to the area specified by the 
last Save As operation. If Save As has been used, the procedure is saved 
locally. 

Save As	 displays a file selection dialog window that allows the user to save the 
current procedure with a new name. This dialog allows the user to save 
the procedure to either a local area or to a CM staging area. Procedure 
saved to the staging area will undergo a formal CM procedure. 

Print	 displays a file selection dialog window that allows the user to print a 
selected procedure (default is the current procedure). 

Quit exits the Procedure Editor. 

The Edit menu contains the options that allow the user to perform typical cut, copy, paste, find 
and replace operations. The Edit menu options include: 

Undo performs an undo of the last edit operation. 

Cut deletes the selected text and places it into the clipboard. 

Copy places a copy of the selected text into the clipboard. 

Paste	 inserts the text in the clipboard into the procedure text at the current cursor 
location 

Delete deletes the selected text. 

Find	 activates a find dialog that allows the user to either find and highlight the 
next occurrence of a specified text string or to highlight all occurrences of 
the text string. 

Replace	 activates a replace dialog that allows the user to either find the next 
occurrence of a one text string and replace it with another specified string 
or to replace all occurrences of a text string. 
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The Tools menu contains options that invoke procedure-related tools to assist the user. These 
options include: 

Command Request invokes the Command Request window (see Section A.6.3). 

Command Builder toggles the Command Builder (see Section A.2.8). 

The Help menu contains options that provide context-sensitive help for the user. Section A.2.7 
contains further information about the Help utility. 

The Validate button initiates the validation of the procedure by the Command Management 
Subsystem. This action will also perform a syntax check of the procedure if the syntax check 
status indicator is not set to PASS (see Section A.2.7.4 below). 

The Check Syntax button initiates a syntax check of the directive text. 

A.2.7.4 Procedure Editor Output 

The Procedure Editor outputs includes status messages, a warning dialog, syntax and validation 
indicators, informational dialogs, saved procedure files, and updated procedure information. 
Status messages indicate the completion status of user-specified operations, including: 

• Loading (reading) a procedure file, 

• Saving (writing) a procedure file, 

• Checking the syntax of a procedure, 

• Validating a procedure, 

• Printing a procedure, 

• Searching for text (number of occurrences found), and 

• Replacing text (number of replacements performed). 

A warning dialog is displayed when a user attempts to create a new procedure, open an existing 
procedure, or exit the editor if modifications have been made to the current procedure since the 
last save operation. The warning dialog provides options to save the current procedure, discard 
the procedure modifications, or cancel the current action (e.g., cancel the quit operation). 

The syntax and validation indicators use both color and text to indicate the respective status of 
the current procedure. The values displayed by these indicators are PASS (green), ???? 
(yellow), and FAIL (red). The ???? is used to signify an unknown state. Anytime that the 
procedure text is modified, the indicators display this state. 

An informational dialog is displayed whenever syntax or validation errors are detected. This 
dialog contains the error messages generated by the syntax or validation check, including the 
directive text, if appropriate. 

The procedure file and procedure information are saved as the result of a save (or save as) 
operation. The status of the save operation is displayed to the user via one of the status message 
described above. A procedure may be saved to either a local area of to a CM staging area. A 
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procedure saved to the CM staging area will undergo a formal CM approval process before it can 
be used in an operational environment. Only procedures that pass validation may be saved to the 
CM staging area. 

A.2.8 Command Builder 

Command Builder 

Directive Keywords 

<<< List of Keywords >>> 

Commands 

<<< List of Cmd Mnemonics >>> 

<<< List of Parameters >>> 

Filter AM1-MISR 

AM1-CERES 

AM1-COMMS

(discrete only) 
<<< List of Qualifiers >>> 

All 

Parameters 

(analog and discrete) 

Qualifiers 
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Figure A.2.8-1 Command Builder (Qualifiers) 

Command Builder 

Directive Keywords 

<<< List of Keywords >>> 

Commands 

<<< List of Cmd Mnemonics >>> 

Limits 

350.0 
332.5 

157.5 

150.0 

<<< List of Parameters >>> 

Filter 

(analog and discrete) 

Parameters 

All 

AM1-MISR 

AM1-CERES 

AM1-COMMS

RH 

YH 

YL 

RL 

Figure A.2.8-2 Command Builder (Limits) 
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A.2.8.1 Command Builder Usage 

The Command Builder is used in conjunction with the Procedure Editor (see Section A.2.8) to 
dynamically construct ECL directives. The Command Builder is also used with the RTS Load 
Builder (see Section A.4.2) to dynamically construct commands for a RTS load. The Command 
Builder window consists of four scrolling lists, a selection filter, and a set of color-coded boxes 
corresponding to the parameter limits. 

The scrolling lists contain directive keywords, command mnemonics, parameter mnemonics, and 
qualifiers. The directive keywords are the keywords defined by the ECL grammar. The 
parameters and command mnemonics are displayed according to a user-specified 
subsystem/instrument filter. The qualifiers list (see Figure A.2.8-1), which is displayed only 
when a discrete parameter or directive keyword is selected, contains the secondary keyword(s) 
for the selected ECL directive keyword (e.g., CLOSE and CLOSE ALL for the PAGE keyword) 
or the states for a selected discrete parameters (e.g., ON, OFF for MICAMERA). 

The color-coded boxes representing limits (see Figure A.2.8-2) are displayed only when an 
analog parameter is selected. The boxes and limit values are displayed in a vertical column with 
high-red at the top and low-red at the bottom. 

A.2.8.2 Command Builder Access 

The Command Builder is accessed by selecting the Command Builder option from either the 
Utility menu of the Procedure Editor or the Utility menu of the RTS Load Builder. Sections 
A.2.8.3 and A.4.2.3 provide more information about the Procedure Editor and the RTS Load 
Builder option menus, respectively. 

A.2.8.3 Command Builder Input 

The Command Builder provides a user with the capability to dynamically construct directives, 
including commands, using the mouse. A single left-button click on either the directive keyword 
list or the parameter list highlights the selection and updates either the qualifiers list or the limit 
boxes according to the following rules: 

Select Updates 

directive keyword qualifiers list - secondary keyword(s) 

discrete parameter qualifiers list - valid states 

command mnemonic n/a 

analog parameter limit boxes - current limit values 

A double left-button click on any item in a list will insert the item (i.e., directive keyword, 
command mnemonic, parameter mnemonic, or qualifier) into the procedure or RTS load contents 
text at the current cursor location (note: only the command mnemonic items may be selected 
when the Command Builder is used with the RTS Load Builder). If a user double-clicks on one 
of the limit boxes, a symbolic constant (e.g., high-red, high-yellow, nominal, low-yellow, low­
red) will be placed into the procedure text. This symbolic constant will be evaluated when the 
procedure is executed. 
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A Selection Filter window may be accessed by selecting the Filter button on the Command 
Builder window. The Selection Filter window allows a user to construct a set of filters for the 
parameter and command lists. This set of selection filters is then displayed in a scrolling window 
above the parameter list. The contents of the parameter list are defined according to the filters 
selected by the user. A user may select the All button to select all filters in the set. Section A.3.2 
provides a further description of the Selection Filter utility. 

A.2.8.4 Command Builder Output 

The output of the Command Builder consists of user-constructed directives that are inserted into 
the editor text. These directives may include a combination of directive keywords, parameter 
mnemonics, command mnemonics, qualifiers (secondary keywords and discrete states), and 
symbolic constants representing parameter limits. 

A.2.9 Reports 

A.2.9.1 Report Selector 

A.2.9.1.1 Report Selector Usage 

The Report Selector (Figure A.2.9.1-1) is used by the Flight Operations Team (FOT) and 
Instrument Operations Team (IOT) members to select the type of report they wish to generate. 
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Figure A.2.9.1-1. Report Selector Window 

A.2.9.1.2 Report Selector Access 

The Report Selector may be accessed by any user from the Tools menu located on the Control 
window (see Section A.1.8). 

A.2.9.1.3 Report Selector Input 

The Report Selector window allows the user to select the type of report they wish to generate. 
The user may specify parameters to restrict the types of reports selections displayed. These 
parameters include: 

•	 Both, On Demand, Periodic (radio box) - default value is Both. This radio box controls 
whether only On Demand or Periodic or Both report types are displayed. 
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•	 Subsystem (option menu) - default value is All; other options include Custom, Analysis, 
Command Management, Data Management, Planning & Scheduling, Resource 
Management, Telemetry and User Interface. 

• Vehicle (option menu) - default value is AM1; other options include Chemistry and PM1. 

The Available Reports list is used to select the type of report desired. The available reports are 
listed alphabetically with a qualifier of either "On Demand" or "Periodic". The user selects the 
type of report with the mouse and then pushes the Ok or Apply button at the bottom of the 
window. This will bring up the select report template dialog box. 

Four buttons are located along the bottom of the Report Selector window. The Ok button will 
remove the Report Selector window, and bring up the selected report template dialog box. The 
Apply button will leave up the Report Selector window, and bring up the selected report 
template dialog box. The Cancel button will ignore any selections and remove the Report 
Selector window. The Help button activates a window that provides help information about the 
Report Selector. 

A.2.9.2 Periodic Report Selector Dialog 

A.2.9.2.1 Periodic Report Selector Dialog Usage 

The Periodic Report Selector Dialog (Figure A.2.9.2-1) is used by the Flight Operations Team 
(FOT) and Instrument Operations Team (IOT) members to browse, print, or copy to a file a 
periodically generated report such as the Solid State Recorder Status Report. 
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Figure A.2.9.2-1. Periodic Report Selector Dialog 

A.2.9.2.2 Periodic Report Selector Dialog Access 

The Periodic Report Selector Dialog may be accessed by any user from the Report Selector 
window (see Section A.2.9.1). 

A.2.9.2.3 Periodic Report Selector Dialog Input 

The Periodic Report Selector Dialog allows the user to select the periodic report they wish. The 
dialog is used to build a template which is used by the report generator to retrieve the periodic 
report. The user can specify parameters which are used by the report generator. The user may 
also pass this template on to the standing order manager. These parameters include: 

• Report Name (text field) - The name of the report (automatically filled in). 

• Author's Name (text field) - The author of this report template (automatically filled in). 

•	 Start Time (text field) - The earliest periodic report the user is interested in (optional for 
normal requests, required for standing orders). The user may use the Select Time button 
to bring up the time selector to assist in filling in the start and stop times. 

A-84 605-CD-003-001




•	 Stop Time (text field) - The latest periodic report the user is interested in (optional for 
normal requests, required for standing orders). The user may use the Select Time button 
to bring up the time selector to assist in filling in the start and stop times. 

• Browser (toggle button) - Generate the report and display it in the Report Browser. 

• Printer (toggle button) - Generate the report and send it to the printer. 

• Browser (toggle button) - Generate the report and save it to a file. 

The Available Reports list is used to select the periodic report desired. The available reports are 
listed in descending chronological order. The user selects the periodic report with the mouse and 
then pushes the Ok or Apply button at the bottom of the window. This will generate a report 
template and pass it to the Report Generator, or the Standing Order Manager in the case of 
Standing Orders. The Find Latest button automatically selects the latest report. The Find 
Closest button automatically selects the report closest to the specified start/stop time period. 

Five buttons are located along the bottom of the Periodic Report Selector Dialog. The Ok button 
will remove the Periodic Report Selector Dialog, and pass on the report template for processing. 
The Apply button will leave up the Periodic Report Selector Dialog, and pass on the report 
template for processing. The Standing Order button will bring up the Standing Order Dialog 
and allow the user to turn the current report template into a Standing Order. The Cancel button 
will ignore any selections and remove the Periodic Report Selector Dialog. The Help button 
activates a window that provides help information about the Periodic Report Selector Dialog. 

A.2.9.3 On Demand Report Selector Dialog 

A.2.9.3.1 On Demand Report Selector Dialog Usage 

The On Demand Report Selector Dialog (Figure A.2.9.3-1) is used by the Flight Operations 
Team (FOT) and Instrument Operations Team (IOT) members to generate an On Demand report 
such as the Parameter Out-Of-Limits Report. 
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Figure A.2.9.3-1. On Demand Report Selector Dialog 

A.2.9.3.2 On Demand Report Selector Dialog Access 

The On Demand Report Selector Dialog may be accessed by any user from the Report Selector 
window (see Section A.2.9.1). 

A.2.9.3.3 On Demand Report Selector Dialog Input 

The On Demand Report Selector Dialog allows the user to specify the data required for the on 
demand report they wish. The dialog is used to build a template which is used by the report 
generator to generate the on demand report. The user can specify parameters which are used by 
the report generator. The user may also pass this template on to the standing order manager. 
These parameters include: 

• Report Name (text field) - The name of the report (automatically filled in). 

• Author's Name (text field) - The author of this report template (automatically filled in). 
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•	 Start Time (text field) - The earliest periodic report the user is interested in (optional for 
normal requests, required for standing orders). The user may use the Select Time button 
to bring up the time selector to assist in filling in the start and stop times. 

•	 Stop Time (text field) - The latest periodic report the user is interested in (optional for 
normal requests, required for standing orders). The user may use the Select Time button 
to bring up the time selector to assist in filling in the start and stop times. 

• Browser (toggle button) - Generate the report and display it in the Report Browser. 

• Printer (toggle button) - Generate the report and send it to the printer. 

• Browser (toggle button) - Generate the report and save it to a file. 

The Parameter Out-Of-Limits Report is an example of an on demand report. There will be at 
least 30 different on demand reports available. Each will have a unique dialog. In the case of the 
Parameter Out-Of-Limits Report, the user is required to specify the period of time of interest as 
well as the parameters of interest. The parameters are selected using a standard subsystem filter 
along with a double scrolling list selector. 

Five buttons are located along the bottom of the On Demand Report Selector Dialog. The Ok 
button will remove the On Demand Report Selector Dialog, and pass on the report template for 
processing. The Apply button will leave up the On Demand Report Selector Dialog, and pass on 
the report template for processing. The Standing Order button will bring up the Standing Order 
Dialog and allow the user to turn the current report template into a Standing Order. The Cancel 
button will ignore any selections and remove the On Demand Report Selector Dialog. The Help 
button activates a window that provides help information about the On Demand Report Selector 
Dialog. 

A.2.9.4 Custom Report Dialog 

A.2.9.4.1 Custom Report Dialog Usage 

The Custom Report Dialog (Figure A.2.9.4-1) is used by the Flight Operations Team (FOT) and 
Instrument Operations Team (IOT) members to generate a custom report. 
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Figure A.2.9.4-1. Custom Report Dialog 

A.2.9.4.2 Custom Report Dialog Access 

The Custom Report Dialog may be accessed by any user from the Report Selector window (see 
Section A.2.9.1). 

A.2.9.4.3 Custom Report Dialog Input 

The Custom Report Dialog allows the user to define the contents of a custom report. The dialog 
is used to build a template which is used by the report generator to generate the custom report. 
The user can specify parameters which are used by the report generator. The user may also pass 
this template on to the standing order manager. These parameters include: 
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• Report Name (text field) - The name of the report (automatically filled in). 

•	 Load (push button) - Load an existing custom report template for editing (brings up a file 
selector dialog). 

• Author's Name (text field) - The author of this report template (automatically filled in). 

•	 Start Time (text field) - The earliest periodic report the user is interested in (optional for 
normal requests, required for standing orders). The user may use the Select Time button 
to bring up the time selector to assist in filling in the start and stop times. 

•	 Stop Time (text field) - The latest periodic report the user is interested in (optional for 
normal requests, required for standing orders). The user may use the Select Time button 
to bring up the time selector to assist in filling in the start and stop times. 

• Browser (toggle button) - Generate the report and display it in the Report Browser. 

• Printer (toggle button) - Generate the report and send it to the printer. 

• Browser (toggle button) - Generate the report and save it to a file. 

A custom report can be a collection of analysis products (graphs, tables), routine reports, page 
snaps, free form text and ASCII files. The user defines which items should be placed in the 
report and in what order. Towards this end, the Custom Report Dialog has two center sections. 
The first allows a user to analysis request products or reports are available to be inserted into the 
report. The second area allows the user to define the contents of the report. The Analysis 
Requests area is composed of the following items: 

•	 Analysis Requests (single select scrolling list) - List of available analysis request 
templates and products the user wishes to insert into the report. 

• View (push button) - View the selected analysis request in the Analysis Request Window. 

•	 Add (push button) - Add analysis request templates and products to the available list 
(brings up a selection dialog). 

• Delete (push button) - Delete the currently selected analysis request. 

The Routine Reports area is composed of the following items: 

•	 Add (push button) - Add routine reports to the available list (brings up a selection 
dialog). 

• Delete (push button) - Delete the currently selected routine report. 

The report composition area is composed of the following items: 

•	 Report Layout (single select scrolling window) - List of push buttons representing the 
current layout of the report. Every time a new item is added to the report, a button is 
added to the bottom of the scrolling window. The user may select an item (push a button) 
and modify the margin and orientation attributes. 

• View (push button) - View the selected item in the report browser. 

• Up Arrow (push button) - Move the selected item up one place. 
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• Down Arrow (push button) - Move the selected item down one place. 

• Delete (push button) - Delete the currently selected item. 

•	 Insert Analysis Product (push button) - Insert an analysis product. This brings up 
selection dialog with all of the products associated with the specified analysis requests. 

•	 Insert Routine Report (push button) - Insert a routine report. This brings up selection 
dialog with all of the products associated with the specified routine reports. 

•	 Insert Snap (push button) - Insert a page snap. This brings up selection dialog with all 
of the user's page snaps. 

•	 Insert Text  (push button) - Insert free form text. This brings a simple editor into which 
the user enters the text. 

•	 Insert ASCII File (push button) - Insert an ASCII file. This brings up file selection 
dialog. 

• Top Margin (text field) - Item's top margin in inches. 

• Bottom Margin (text field) - Item's bottom margin in inches. 

• Left Margin (text field) - Item's left margin in inches. 

• Right Margin (text field) - Item's right margin in inches. 

• Orientation (radio box) - Item's orientation. This can be either landscape or portrait. 

Five buttons are located along the bottom of the Custom Report Dialog. The Ok button will 
remove the Custom Report Dialog, and pass on the report template for processing. The Apply 
button will leave up the Custom Report Dialog, and pass on the report template for processing. 
The Standing Order button will bring up the Standing Order Dialog and allow the user to turn 
the current report template into a Standing Order. The Cancel button will ignore any selections 
and remove the Custom Report Dialog. The Help button activates a window that provides help 
information about the Custom Report Dialog. 

A.2.9.5 Report Browser Dialog 

A.2.9.5.1 Report Browser Dialog Usage 

The Report Browser Dialog (Figure A.2.9.5-1) is used by the Flight Operations Team (FOT) and 
Instrument Operations Team (IOT) members to browse and edit reports. 
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Figure A.2.9.5-1. Report Browser Dialog 

A.2.9.5.2 Report Browser Dialog Access 

The Report Browser Dialog may be accessed by any user from the Tools menu located on the 
Control window (see Section A.1.8). 

A.2.9.5.3 Report Browser Dialog Input 

The Report Browser Dialog allows the user to browse or edit a previously generated report. The 
Report Browser Dialog is composed of the following parts: 

•	 Report Types (option menu) - default value is All; other options include Custom, On 
Demand and Periodic. 

•	 Available Reports (single select scrolling list) - A list of all the reports that have been 
generated by the user. The reports are listed alphabetically by type and are also tagged 
with their report type (custom, on demand or periodic). 

• Edit Report (push button) - Edit or browse the currently selected report. 
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• Report Selector (push button) - Bring up the Report Selector Dialog. 

• Report Name (uneditable text field) - The name of the currently selected report . 

• Author's Name (uneditable text field) - The author of the currently selected report . 

• Start Time (uneditable text field) - The start time of the currently selected report. 

• Stop Time (uneditable text field) - The stop time of the currently selected report. 

Four buttons are located along the bottom of the Report Browser Dialog. The Ok button will 
remove the Report Browser Dialog, and pass on the report template for processing. The Apply 
button will leave up the Report Browser Dialog, and pass on the report template for processing. 
The Cancel button will ignore any selections and remove the Report Browser Dialog. The Help 
button activates a window that provides help information about the Report Browser Dialog. 

A.2.9.5.4 Report Browser Dialog Output 

The Report Browser Dialog may be accessed by any user from the Report Selector window (see 
Section A.2.9.1). 

A.3.1 Time Selector 

Single Time Selector 

Absolute Local Time : 95/100 10:10:10.000 

Time Date 

10:10:10.000 95/100 

OK Cancel Help Apply 

Local 

UTC 

Time 

Event 

Figure A.3.1-1 Single Time Selector 
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Pair Time Selector 

TimeDate 

OK Cancel HelpApply 

Local 

UTC 

Time 

Event 

Hour 

Duration 

10:10:10.00095/100Start 

10:10:10.00095/100Stop 

Absolute Local Start Time: 95/100 10:10:10.000 

Absolute Local Stop Time : 95/100 10:10:10.000 

Figure A.3.1-2 Pair Time Selector 

Interval Time Selector 

Time Date 

OK Cancel Help Apply 

Local 

UTC 

Time 

Event 
Hour 
Duration 

10:10:10.000 95/100 Activate 

10:10:10.000 95/108 End 

Local Activation Time : 95/100 10:10:10.000 

Local Ending Time : 95/108 10:10:10.000 

Frequency : Every 2 Day 

Frequency: Every 2 Day 

Figure A.3.1-3 Interval Time Selector 

A.3.1.1 Time Selector Usage 

The time selector is a utility of FOS user interface and will be used in many different areas of the 
FOS user interface whenever the user needs to specify time values. Such as off-line analysis, 
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historical tables or graphs, replays, event display will use the time selector to specify a time, a 
pair of start and stop times, or a time interval. The time values could be an absolute time, an 
orbital event, or a relative time. The time interval could be a specified event (e.g. every n orbits) 
or a time period (e.g. every n hours). 

A.3.1.2 Time Selector Access 

The time selector can be accessed from off-line analysis, historical tables or graphs, replays, or 
event display by activating single time selector, pair time selector, or interval time selector. 

A.3.1.3 Time Selector Input 

The time selector dialog contains five parts -- title area, option area, user input area, information 
area, and button area. 

The title area displays three different types of time selector -- single time selector, pair time 
selector, and interval time selector. 

The option area contains sets of toggle buttons that user can select. These will change the 
meaning of the input time data. The absolute/relative toggle buttons is used for absolute/relative 
time. An absolute time is a time which contains year, day, hour, minute, and second. A relative 
time is a time which contains only hour, minute, and second. The local/utc toggle buttons is used 
for local/utc time. The time/event toggle buttons is used to input time/event. The 
hour/orbit/duration toggle button is used to input hour/orbit or duration. 

The user input area is where the user inputs the time based upon the option that the user sets in 
the option area. In the single time selector, the user will be able to input the single time or the 
single orbital event. In the pair time selector, the user will be able to input the start and stop 
times, the start time and the duration, the start and stop orbital event, and the start orbital event 
and the duration. In the interval time selector, the user will be able to input the activation time, 
the ending time, and the frequency, or the activation time, the duration, and the frequency. 

The information area displays all the options that the user sets and all the times that the user 
inputs after pressing the apply button. 

The button area contains four buttons -- OK button, Apply button, Cancel button, and help 
button. The OK button returns the information displayed in the information area and closes the 
dialog. The Apply button displays the options and the times input from the user in the 
information area. The cancel button closes the dialog without returning the data. The Help button 
provides context-sensitive help for the user. Section A.2.7 contains further information about the 
Help utility. 

A.3.1.4 Time Selector Output 

The time selector outputs times that the user specified. 

The single time selector outputs the single time. The pair time selector outputs the start and stop 
times. The interval time selector outputs activation and end times and frequency. 
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A.3.2 Selection Filter Window 

Figure A.3.2-1. Selection Filter Window 

A.3.2.1 Selection Filter Usage 

The Selection Filter window will be used in many different areas of the FOS user interface. For 
instance, a user will use this utility for filtering a list of items for selection according to a specific 
spacecraft (e.g. AM-1, PM-1, ACRIMSAT, etc.), spacecraft subsystem (e.g. GN&C, C&DH, 
TCS, COMM, etc.), instrument (e.g. MISR, CERES, ASTER, etc.), or ground system (e.g. NCC, 
EDOS, ECOM, etc.). 

A.3.2.2 Selection Filter Access 

The Selection Filter window can be accessed from several windows such as the Quick Analysis 
window, the Analysis Request window, and the Analysis Product Selector window. 

A.3.2.3 Selection Filter Input 

The Selection Filter window contains three Display Labels, three Data Display areas for 
displaying multiple levels of data and one Selected Data Display area for selected items, a Select 
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All function (All -->), a Select function (-->), a Deselect All function (<-- All), a Deselect 
function (<--), a OK button, a Cancel button, and a Help button. 

The mouse is used to expand or shrink multiple levels of data and highlight the data for future 
operations. A 'Double Click' on a single item in the Data Display area will expand to the next 
level of data associated with that item if available. The Selection Filter Window has the 
capability to go to n-levels. If a user continues to expand to the next level and so on, simply 
double click on the desire item, the next level of data will be shown in the right most Data 
Display area and the existing data in each Data Display area will be shifted to the next left Data 
Display area. For instance, if AM-1 is in the first (left most) Data Display area, a 'Double Click' 
on AM-1 will expand to the next level of data in the second Data Display area. The second 
(immediate right) Data Display area will show a list of subsystems/instruments such as ASTER, 
MISR, MOPITT, and S/C BUS, etc. A 'Double Click' on S/C BUS will expand to the next level 
of data that displays in the third Data Display area. The list of items is C&DHS, EAS, EPS, and 
GN&CS, etc. A 'Single Click' on any item in the Data Display area will clear all the data in the 
right Data Display area (s). 

The Left Arrow button has the capability to scroll each level of data to the left Data Display areas 
if the data has expanded more than three levels. 

The Right Arrow button has the capability to scroll each level of data to the right Data Display 
areas if the data has expanded more than three levels. 

The Select All button has the capability to select all the items in the right most Data Display area. 

The Select button has the capability to select all the highlighted items in the right most Data 
Display area. 

The Deselect All button has the capability to deselect all the items in the Selected Data Display 
area. 

The Deselect button has the capability to deselect all the highlighted items in the Selected Data 
Display area. 

The OK button sends the selected list of items in the Selected Data Display area to the window 
that invoked the Selection Filter window and then closes the window. 

The Cancel button closes the Selection Filter window. 

The Help button provides context-sensitive help for the user. Section A.2.7 contains further 
information about the Help utility. 

A.3.2.4 Selection Filter Output 

The Selection Filter window returns a list of selectable items to the invoking window. 
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A.4.1 Table Load Builder 

Table Load Builder 

Table Name: 

File Utility Help 

Table Type: 

Field #1: 

Field #2: 

Field #3: 

Spacecraft ID: 

Instrument ID: 

<< status line>> 

: 

: 

Uplink Time Period 

Start Time: Stop Time: Select Time 

Figure A.4.1-1. Table Load Builder 

A.4.1.1 Table Load Builder Usage 

The Table Load Builder is used to create and generate table loads. This tool allows a user to 
generate a table load file and send it to Command Management Subsystem (CMS). A user may 
use previously loaded file parameters or table load dumps to create a new table load. 

The Table Load Builder includes a menu bar with three pull-down menus: File, Utility, and 
Help. Each of these menus is described in Section A.5.1.3 below. Just below the menu bar is an 
identification area. This area contains the table name, table type, spacecraft ID, and instrument 
ID. The uplink time period area is below the identification area. It allows user to define the 
uplink start and stop times. A scrollable text widget locate at the bottom of the window 
represents the status messages area. Status messages indicating the completing of user-activated 
operations (e.g., Table Load Generated) are displayed in this area. If an error occurs during an 
operation, the status message will provide information to assist the user in resolving the error. 
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A.4.1.2 Table Load Builder Access 

The Table Load Builder is accessed from the Tools menu on the Control Window. This tool is 
only accessible by authorized personnel that have been granted access to create table loads. 

A.4.1.3 Table Load Builder Input 

The Table Load Builder provides the user with standard editing capabilities through a 
combination of keyboard and mouse input. The keyboard is used primarily to enter or modify 
the table name, spacecraft, and instrument identifiers. The mouse is used to perform standard 
Motif selection operations, and to select options from the menu bar and pull-down menus. 

The Table Load Builder contains three pull-down menus: File, Utility, and Help. The File menu 
options include 

New...	 displays a selection dialog window. It allows a user to select a table 
template. 

Open Table...	 displays a selection dialog window. It allows a user to select table 
parameters from existing table load contents. 

Open Dump...	 displays a selection dialog window. It allows a user to select table 
parameters from table load dumps. 

Save allows user to save the current table parameters. 

Quit exits the Table Load Builder. 

The Utility menu contains the options that allow the user to perform special operations. The 
Utility menu options include: 

Validate	 validates the table parameters for each field of the table template. It will 
generate a message on the status line indicating whether the validation 
process is successful or not. 

Generate	 will automatically validates the table parameters and sends a load 
generation request to CMS. CMS creates a new table load if no errors are 
detected. 

The Help menu contains an option that provides context-sensitive help for the user. Section 
A.2.7 contains further information about the Help utility. 

The Uplink Time Period area allows a user to specify a valid uplink start and stop times. The 
Select Time button will display a time selector window (refer to section A.3.1). The Start Time 
and Stop Time fields allow user to specify the starting time and stopping time for uplink. 

A.4.1.4 Table Load Builder Output 

The Table Load Builder will update metadata and table load contents. The Table Load Builder 
outputs includes status messages. Status messages are displayed at the status line area. Status 
messages indicate the generic status of user-specified operations. Error message(s) will appear in 
the status area if user has entered invalid table parameter(s). Field(s) in error will be highlighted. 
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A.4.2 RTS Load Builder 

RTS Load Builder 

RTS Number: 
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032 
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Validate 

Figure A.4.2-1. RTS Load Builder Window 

A.4.2.1 RTS Load Builder Usage 

The RTS Load Builder is used by authorized members of the Flight Operations Team (FOT) and 
Instrument Operations Team (IOT) to create and generate Relative Time Sequence (RTS) loads. 
This tool allows a user to create a RTS load contents file containing directives with relative time 
offsets. Once the load contents file has been completed, the RTS Load Builder provides the 
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capability for the user to send this file to CMS where the corresponding binary RTS load is 
created for uplink at a later time. A user may open an existing RTS load contents file and modify 
its contents. The RTS Load Builder is based upon the Procedure Editor (see Section A.2.8), and 
therefore includes standard editing operations (e.g., cut, copy, paste, etc.) for entering RTS 
directives. 

The RTS Load Builder includes a menu bar with four pull-down menus: File, Edit, Utility, and 
Help. Each of these menus is described in Section A.4.2.3 below. Just below the menu bar is an 
identification line. This line contains the sequence number of the RTS load and its associated 
subsystem or instrument (e.g., AM1-COMMS). The user may modify the subsystem field, if 
appropriate. Underneath the identification line is a pair of time fields. These fields allow a user 
to define the uplink window for the RTS load. The times may be entered manually, or the user 
may access the time selector (see Section 2.3.1) to specify the times. Underneath the time fields 
is a text field where the user may specify the function or purpose of the table load (e.g., 
PATCH03). The text in this field is appended to the label 'RTSxxx', where 'xxx' is the RTS 
number, to form the name of the RTS load. A scrolling text window, located below this text 
field, contains the RTS load contents (i.e., directives and relative time offsets) entered by the 
user. Standard keyboard and mouse editing functions (e.g., Page Up, Page Down, highlighting 
with the mouse, etc.) are accommodated in this window. Under the text window is a status line 
The status line displays messages indicating the completion of user-activated operations (e.g., 
RTS load generated). If an error occurs during an operation, the status message will provide 
information to assist the user in resolving the error. Along the bottom of the RTS Load Builder 
window is a text input field that allows a user to enter a line number for the Go To operation. 
Next to the Go To text field are two buttons that allow the user to validate the load contents or to 
generate the binary load. 

A.4.2.2 RTS Load Builder Access 

The RTS Load Builder is accessed from the Tools menu on the Control Window. This tool is 
only accessible by FOT and IOT personnel that have been granted access to create RTS loads. 

A.4.2.3 RTS Load Builder Input 

The RTS Load Builder provides the user with standard editing capabilities through a 
combination of keyboard and mouse input. The keyboard is used primarily to enter the RTS load 
contents, to modify the associated subsystem/instrument identifier, and to enter the load function. 
Support for keyboard control keys (e.g., Page Up, Page Down, Home, End, etc.) is also provided. 
Accelerator keys are provided for both the menu bar and the pull-down menu options (e.g., 
<alt>F displays the File menu). 

The mouse is used to position the cursor within the RTS load contents, to perform standard Motif 
selection operations (e.g., double-click selects the current word, triple-click select the current 
line, quadruple-click select all text), to select options from the menu bar and pull-down menus, 
and to select the Validate or Generate buttons. The RTS Load Builder menu bar contains four 
pull-down menus: File, Edit, Utility, and Help. The File menu options include: 

New opens a template file that is used to create a new RTS load contents file. 
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Open	 displays a file selection dialog window that allows the user to open an 
existing RTS load contents file. An existing file can be used to create a 
new RTS load. 

Save	 saves the current RTS load contents file. This option should be used in 
cases where the user wants to save the results of the current edit session 
without generating a load. 

Print	 displays a file selection dialog window that allows the user to print a 
selected RTS load contents file (default is the current RTS load contents 
file). 

Quit exits the RTS Load Builder. 

The Edit menu contains the options that allow the user to perform typical cut, copy, paste, find, 
and replace operations. The Edit menu options include: 

Undo performs an undo of the last edit operation. 

Cut deletes the selected text and places it into the clipboard. 

Copy places a copy of the selected text into the clipboard. 

Paste	 inserts the text in the clipboard into the procedure text at the current 
cursor location 

Delete deletes the selected text. 

Find	 activates a find dialog that allows the user to either find and highlight 
the next occurrence of a specified text string or to highlight all 
occurrences of the text string. 

Replace	 activates a replace dialog that allows the user to either find the next 
occurrence of a one text string and replace it with another specified 
string or to replace all occurrences of a text string. 

The Utility menu provides access to the Command Builder, which may be used as an aid in 
constructing RTS commands. At this time the Utility menu includes only one option: 

Command Builder activates/deactivates the Command Builder (see Section A.2.9). 

The Help menu contains options that provide context-sensitive help for the user. Section A.2.7 
contains further information about the Help utility. 

The user may specify the start and stop times for the load uplink window by either manually 
entering these times in two text fields or by accessing the Time Selector utility. The Time 
Selector, which is described in Section A.3.1, is accessed via a pushbutton, Select Time, located 
to the right of the start and stop time fields. The Time Selector updates the start and stop time 
text fields when the user closes this window. 
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A.4.2.4 RTS Load Builder Output 

The RTS Load Builder outputs includes status messages, a warning dialog, an informational 
dialog, saved RTS load contents files, and updated RTS load contents information. Status 
messages indicate the completion status of user-specified operations, including: 

• Opening (reading) a RTS load contents file, 

• Saving (writing) a RTS load contents file, 

• Printing a RTS load contents file, 

• Validating the load contents, 

• Generating the binary load file, 

• Searching for text (number of occurrences found), and 

• Replacing text (number of replacements performed). 

A warning dialog is displayed when a user attempts to create a new RTS load contents file, open 
an existing RTS load contents file, or exit the RTS Load Builder if modifications have been 
made to the current RTS load contents since the last save or generate operation. The warning 
dialog provides options to save the current contents file, discard the load contents modifications, 
or cancel the current action (e.g., cancel the quit operation). 

An informational dialog is displayed whenever validation or load generation errors are detected. 
This dialog contains the error messages, including the offending directive text, if appropriate. 

The RTS load contents file and RTS load contents information are saved as the result of a save 
operation. The status of these operations is displayed to the user via one of the status message 
described above. 
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A.4.3 Ground Script Display 

Figure A.4.3-1. Ground Script Display Window 

Figure A.4.3-2. Ground Script Error Message Dialog 
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A.4.3.1 Ground Script Display Usage 

The Ground Script Display window (figure A.4.3-1) is used for displaying and printing ground 
scripts generated by the Command Management Subsystem. 

A.4.3.2 Ground Script Display Access 

The Ground Script Display window can be accessed from the tool menu. 

A.4.3.3 Ground Script Display Input 

The Ground Script Display window provides the capability for viewing and printing ground 
scripts based on specific time ranges. 

The Ground Script Display window includes the following input fields: 

spacecraft id the spacecraft that the requesting ground script is based upon 

start time the requesting starting time of the ground script 

stop time the requesting ending time of the ground script 

search string	 the string pattern that is to be searched for in 
the ground script 

expand procedure flag	 the indication of whether or not to display or print the ground 
script with the embedded command language procedures expanded 

string search flag	 the indication of searching for the next line containing this search 
string 

string filter flag	 the indication of searching for only those lines having this search 
string 

The Ground Script Display window includes a text output field: 

ground script display the display area for the ground script contents 

The Ground Script Display window also includes seven action push buttons: 

Select Time	 activates a pair time selector window to select a pair of start and 
stop times 

Reset	 re-displays the entire requested ground script if display has 
changed (e.g. if the display previously had been filtered for a 
specific sting) 

Display displays the ground script onto the viewing area 

Print activates a print dialog window 

Help	 invokes a message dialog box describing the capabilities and how 
to use the Ground Script Display window 

Close closes the Ground Script Display tool 
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A.4.3.4 Ground Script Display Output 

The Ground Script Display window displays or prints the ground script requested based on the 
spacecraft id, start time, and stop time. 

A.4.4 ATC Buffer Display 
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Figure A.4.4-1. ATC Buffer Display 

A.4.4.1 ATC Buffer Display Usage 

The ATC Buffer Display window will allow the user to view the command-to-memory map of 
an Absolute Time Command (ATC) buffer. This display will allow the user to highlight 
commands within the buffer according to various criteria. 
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The ATC Buffer Display includes a menu bar with three pull-down menus: File, Options, and 
Help. Each of these menus is described in Section A.4.4.3 below. Just below the menu bar is an 
identification area. It contains the spacecraft ID, start and stop address. Underneath that is the 
highlight filter area which contains the instrument name, subsystem name, and inhibit group 
name. It also indicates what highlight criteria are being set. The buffer contents are located 
below the identification area. It displays the absolute time command address, indicator, and 
command text. A text widget located at the bottom of the window represents the status messages 
area. Status messages indicating the completing of user-activated operations (e.g., File Open) are 
displayed in this area. 

A.4.4.2 ATC Buffer Display Access 

The ATC Buffer Display is accessed from the Tools menu on the Control Window. 

A.4.4.3 ATC Buffer Display Input 

The ATC Buffer Display provides the user with standard input capabilities through a 
combination of keyboard and mouse input. The keyboard is used primarily to specify the inhibit 
group, instrument, and subsystem identifiers for the highlight criteria. The mouse is used to 
perform standard Motif selection operations and to select options from the menu bar and pull­
down menus. User may turn on/off certain highlight criteria by selecting the toggle button right 
next to it, e.g., user may filter out all the buffer which contains critical command by turning off 
the critical highlight filter. 

The ATC Buffer Display contains three pull-down menus: File, Options, and Help. The File 
menu options include: 

Open allows the user to access other ATC buffers. 

Quit exits the ATC Buffer Display window. 

The Options menu contains the options that allow the user to perform special operations. The 
Options menu options include: 

Clear All Filter turns off all filtering of the buffer contents in response to a user request. 

Set All Filter	 sets all filtering options of the buffer contents according to the user­
specified criteria. 

Clear All 

Highlight	 turns off all highlighting of the buffer contents in response to a user 
request. 

Set All Highlight sets all highlighting options of the buffer contents according to the user­
specified criteria. 

The Help menu contains an option that provides context-sensitive help for the user. Section 
A.2.7 contains further information about the Help utility. 
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A.4.4.4 ATC Buffer Display Output 

The ATC Buffer Display will display the ATC buffer for a spacecraft. The ATC Buffer Display 
will display the command-to-memory map of an ATC buffer and highlight the contents of the 
ATC buffer according to the criteria. The ATC Buffer Display outputs includes status messages. 
Status messages are displayed at the status line area. Status messages indicate the generic status 
of user-specified operations. 

A.4.5 RTS Buffer Display 
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Figure A.4.5-1. RTS Buffer Display 
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Figure A.4.5-2. RTS Command Display 

A.4.5.1 RTS Buffer Display Usage 

The RTS Buffer Display (Figure A.4.5-1) will display the map of the Relative Time Sequence 
(RTS) buffers. It will allow the user to highlight the RTS buffer according to various criteria. In 
addition, the display will indicate linkages between the RTS buffers. A user may also select an 
RTS buffer and view its command-to-memory map. 

The RTS Buffer Display includes a menu bar with three pull-down menus: File, Options, and 
Help. Each of these menus is described in section A.4.5.3 below. Below the menu bar is an 
identification area. This area contains the spacecraft name, instrument name, and owner's name. 
It also indicates what highlight criteria are being set. Beneath the identification area is the 
mapping area. It also contains the highlight code for RTS buffer. The graphical display of RTS 
buffer is displayed at this area. A text widget locate at the bottom of the window represents the 
status messages area. Status messages indicating the completing of user-activated operations 
(e.g., updating highlight options) are displayed in this area. 

The RTS Command Display window is enabled by double clicking a buffer in the RTS Buffer 
Display window. The RTS commands which belong to this buffer will display in this window. 
For spacecraft AM-1, The maximum number of RTS commands for each buffer is sixteen. 
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Additional RTS Command Display can be displayed by double clicking a row of RTS command 
which contains a linkage to another RTS buffer in the RTS Command window. 

A.4.5.2 RTS Buffer Display Access 

The RTS Buffer Display is accessed from the Tools menu on the Control Window. 

A.4.5.3 RTS Buffer Display Input 

The RTS Buffer Display provides the user with standard input capabilities through a combination 
of keyboard and mouse. The keyboard is used primarily to specify the instrument name, 
subsystem name, and ownership criteria. The mouse is used to perform standard Motif selection 
operations and to select options from the menu bar and pull-down menus. User can turn on/off 
certain highlight criteria by selecting the toggle button right next to it. 

The RTS Buffer Display contains three pull-down menus: File, Options, and Help. The File 
menu options include: 

Quit exits the RTS Buffer Display window. 

The Options menu contains the options that allow the user to perform special operations. The 
Options menu options include: 

Clear All Highlight	 turns off all highlighting of the buffer contents in response to a 
user request. 

Set All Highlight	 sets all highlighting options of the buffer contents according to the 
user-specified criteria. 

Show Linkage highlights the selected buffer linkage. 

The Help menu contains an option that provides context-sensitive help for the user. Section 
A.2.7 contains further information about the Help utility. 

The RTS Command Display (Figure A.4.5-2) provides the user capabilities to view the RTS 
command text for a selected buffer. The Close button allows the user to dismiss the window. 
The Help button contains an option that provides context-sensitive help for the user. Section 
A.2.7 contains further information about the Help utility. 

A.4.5.4 RTS Buffer Display Output 

The RTS Buffer Display window will display the map of the Relative Time Sequence (RTS) 
buffer graphically. The second column in the map area will be highlighted with appropriate 
colors to represent the different criteria. If a user double clicks on a map area, a command-to­
memory map window will be displayed. This window will display the RTS commands 
associated with the selected map area. If a user selects a buffer and executes the show linkage 
option, all the other buffer links to the selected buffer will be highlighted. The ATC Buffer 
Display outputs includes status messages, which are displayed in the status line area. Status 
messages indicate the generic status of user-specified operations (e.g., updating highlight 
options). 
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A.5.1 Procedure Control Window 
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Figure A.5.1-1. Procedure Control Window 

A.5.1.1 Procedure Control Usage 

The Procedure Control window is used by the user who wants to execute non-command 
procedures. A non-command procedure does not contain any spacecraft or instrument 
commands. Users are able to invoke a procedure at a specified time. Users are also able to 
monitor and control the execution of the procedure. Control functions allow a user to suspend, 
resume, or kill the execution of the procedure. 
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A.5.1.2 Procedure Control Access 

The Procedure Control window can be accessed in two ways: A user can bring up a Procedure 
Control window by typing a start procedure directive with the option in the command line, or by 
selecting Procedure Control via the tool menu. 

A.5.1.3 Procedure Control Input 

The Procedure Control window provides the user the capability for controlling the execution of 
non-command procedures through a combination of keyboard and mouse input. The keyboard is 
used primarily to enter directives in the ECL input line. The mouse is used to perform standard 
Motif selection operations and to select options from the menu bar, pull down menus, and push 
buttons. 

The Procedure Control contains a menu bar that has three pull-down menus: File, Utility, and 
Help. The File menu options include: 

Open	 displays a Procedure Selector dialog that allows the user to open an 
existing procedure. 

Quit quits the Procedure Control window. 

The Utility menu options include: 

Show Cur 

Directive scrolls the procedure display to the current executing directive. 

Find invokes a find dialog to allow a user to search for a specified string. 

The Help menu contains options that provide context-sensitive help for the user. Section 2.2.7 
contains further information about the Help utility. 

There are two radio buttons for Mode: Step and Auto. For Step mode, each directive in the 
procedure will be executed only when the user presses the 'Step' button. For Auto mode, each 
directive in the procedure will be executed automatically once the user resumes the execution of 
the procedure. 

The Resume button resumes the execution of a suspended procedure.


The Suspend button suspends the execution of a procedure.


The Step button executes one directive statement at a time if the procedure mode is step.


The Go button resumes the execution of a procedure if it is in the 'Wait' state. 

The Set Jump button sets a forward jump target in the procedure. Once the currently executing 
directive has completed, execution will jump to the target directive. 

The Clear Jump button deselects a jump target directive. 

The Kill button terminates the execution of a procedure. 
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The Return button returns to the calling (previous level) procedure. This button is insensitive if 
the procedure is at the top level. 

The ECL input line allows a user to enter directives for controlling the execution of a procedure. 

A.5.1.4 Procedure Control Output 

The Procedure Control window displays the executing procedure. This display includes: 

• The procedure name, 

• The procedure status (active or suspended), 

• The procedure mode (step or auto), 

• The start time of the procedure, 

• The status of the executed directives, 

• The current executing directive. 
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A.5.2 Command Control Window 
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Figure A.5.2-1. Command Control Window 
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A.5.2.1 Command Control Usage 

The Command Control window is used to control and monitor commanding of the spacecraft and 
its instrument. A user who has the command authority will be able to use the Command Control 
window for controlling the execution of a ground script. A ground script consists of time­
stamped, time-ordered directives. 

A.5.2.2 Command Control Access 

The Command Control window can be accessed from the tool menu. Only a user with command 
authority may access the Command Control window. 

A.5.2.3 Command Control Input 

The Command Control window provides the user the capability for controlling the execution of 
the ground script. 

The Command Control window contains a menu bar that has five pull-down menus: File, Edit, 
Config., Utility, and Help. The File menu options include: 

Open	 invokes a ground script selector dialog window that allows the user 
to select a ground script from the list. 

Print	 invokes a print dialog to allow a user to print the current executing 
ground script. 

Quit quits the Command Control window. 

The Edit menu options include: 

Copy	 copies one or more lines in the ground script into a buffer 
(clipboard). The user highlights the ground script directive lines to 
copy using the mouse. 

Insert	 inserts the directive lines from the buffer (see Copy above) 
immediately after the selected line in the ground script. 

Undo	 undos the last insert operation. (Cannot undo the last insert once 
the execution of the ground script is resumed). 

The Config menu options include: 

Set Step Mode sets mode to Step. 

Set Auto Mode sets mode to Auto. 

Pre State Check sets prerequisite state check on or off. 

Cmd Verification sets command verification on or off. 

Tlm Verification sets telemetry verification on or off. 

The Utility menu options include: 
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Show Cur Directive scrolls the ground script display to the current executing directive. 

Find invokes a find dialog to allow a user to search for a specified text 
string, a command, a procedure, or a time. 

Command Request	 invokes a command request status window to allow a user to check 
or respond to the command requests. 

Select Procedure	 invokes a procedure selector dialog to allow a user to select a 
procedure off the procedure list. The user can then use the 
procedure selector to insert the procedure into the ground script. 

The Help menu contains options that provide context-sensitive help for the user. Section A.2.7

contains further information about the Help utility.


The Allow button allows a critical command to be sent.


The Send button allows a command to be sent in 'Step' mode.


The Override button overrides the command directive when pre-requisite state check fails.


The Cancel button cancels a command directive.


The Enable button enables one or more directives.


The Disable button disables one or more directives (not executed).


The Yes button allows a CAC to answer yes to a question when prompted.


The No button allows a CAC to answer no to a question when prompted.


The Set Jump button allows a CAC to transfer the execution to a directive in the ground script.


The Clear Jump button allows a CAC to deselect a previously set jump target in the ground

script.


The Go button allows a CAC to resume the execution if the directive is in the wait state.


The Resume button resumes the execution of the ground script.


The Suspend button suspends the execution of the ground script.


The Kill button terminates the execution of the ground script.


The Command Input Line (CMD) allows a CAC to execute a command directive manually. The

CAC enters the command in this field. If an existing directive is selected in the ground script,

the manual directive will be inserted immediately after the selected directive. If no existing

directive is selected in the ground script, the manual directive will be inserted immediately after

the current executing directive.


A.5.2.4 Command Control Output 

The Command Control window displays the executing ground script. This display includes: 

A-115 605-CD-003-001




• The start time of the ground script 

• The stop time of the ground script 

• The spacecraft identifier associated with the ground script 

• The ground script status (active or suspended) 

• The ground script processing mode 

• The current bias time 

• The verification flags (Prerequisite State Check, Command, and Telemetry) 

• The status of the executed directives 

• The current executing directive 

• The count down timer of the next three non-comment directives 
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A.5.3 Command Monitor Window 
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Figure A.5.3-1. Command Monitor Window 

A.5.3.1 Command Monitor Usage 

The Command Monitor window (Figure A.5.3.-1) is used for monitoring the execution of the 
ground script. 

A.5.3.2 Command Monitor Access 

The Command Monitor window can be accessed from the tool menu. This window may be 
accessed by user without command authority in lieu of the Command Control window (reference 
Section A.5.2). 
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A.5.3.3 Command Monitor Input 

The Command Monitor window provides the user the capability for monitoring the execution of 
the ground script. 

The Command Monitor window contains a menu bar that has three pull-down menus: File, 
Utility, and Help. The File menu options include: 

Open	 invokes a ground script selector dialog window that allows the user 
to select a ground script from the list. 

Print	 invokes a print dialog to allow a user to print the executing ground 
script. 

Quit quits the Command Monitor window. 

The Utility menu options include: 

Show Cur Directive scrolls the ground script display to the current executing directive. 

Find invokes a find dialog to allow a user to search for a specified text 
string, a command, a procedure, or a time. 

Command Request	 invokes a command request status window to allow a user to check 
or respond to the command requests. 

The Help menu contains options that provide context-sensitive help for the user. Section A.2.7 
contains further information about the Help utility. 

A.5.3.4 Command Monitor Output 

The Command Monitor window displays the same information that is provided by the Command 
Control window (see Section A.5.3). This display includes: 

• The start time of the ground script, 

• The stop time of the ground script, 

• The spacecraft identifier associated with the ground script, 

• The ground script status (active or suspended), 

• The ground script processing mode, 

• The current bias time, 

• The verification flags (Prerequisite State Check, Command, and Telemetry), 

• The status of the executed directives, 

• The current executing directive, 

• The count down timer of the next three non-comment directives. 
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A.5.4 Command Request Generation 

Command Request Creation 

Originator: 
Request Status: 

Subject: 

Spacecraft ID: 

HelpCancelSend 
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Select Delete Editor 
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: 

: 

Proc. Time 
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SyntaxValidation 
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proc 7 

Directive 

start proc5() 

Please execute proc5 at 
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Argument Procedure 

Builder 

certain time. 
problem, please contact 
R. Moore at 123-4567. 

New 

If there is a 

Figure A.5.4-1. Command Request Creation Window 
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Command Request Procedure Selection 

Filter: 

HelpCancel 

Procedure(s): 

OK 

Both Operational & Local Procedure(s) 
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proc3 
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: 
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Figure A.5.4-2. Command Request Procedure Selection Window 

Command Request Argument Editor 
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HelpCancel 
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Figure A.5.4-3. Command Request Argument Editor Window 
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Command Request Evaluation 
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Figure A.5.4-4. Command Request Evaluation Window 
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Command Request Rejection 

Originator: 

Subject: 

HelpCancel 

proc 5 & 7 

R. Moore 

Reject Reason: 

OK 

10/04/95 Date Acted: 

Date Submitted: 

Rejected By:

10/02/95 

A. Grant

<< text >> 

Figure A.5.4-5. Command Request Rejection Window 

Command Reqest Time Selector 

Help Cancel 

Insert Command Request at cursor position of the Command 

OK 

Insert Command Request at:

Control window 

167/00:00:01 Select Time 

Figure A.5.4-6. Command Request Time Selector Window 

A.5.4.1 Command Request Generation Usage 

The Command Request Generation windows are used to create and evaluate command requests. 
This tool allows an authorized user to create a command request and send it to the Ops 
Controller. The Ops Controller can evaluate the request and determine whether to accept or 
reject the request using this tool. The requests that are accepted are merged by the Command 
Activity Controller (CAC) into the ground script. 

Five windows are being used to define the Command Request Generation process, they are: 

The Command Request Creation window allows user to create and send a command request 
(Figure A.5.4-1). The upper half of the window contains the request subject, originator, 
subsystem ID, spacecraft ID, request status, and instruction fields. Below that is scrolled list 
which contains the user selected procedure(s) list for a command request. It also display the 
validation status, syntax status, execution time, and its directive for each selected procedure. The 
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Time column represents the actual execution time for a procedure. This field is optional. There 
are eight push buttons at the bottom. Each of these buttons will be discuss in section A.5.4.3. 

The Command Request Procedure Selection window (Figure A.5.4-2) allows user to select 
procedure for a command request. User can select to display local procedure(s), operational 
procedure(s), or both. If the same procedure exist in both directories, only the local one will be 
used. 

The Command Request Argument Editor window (Figure A.5.4-3) allows user to edit the 
argument(s) value of a selected command request procedure. The name of the procedure, and its 
number of argument will be displayed. If argument(s) does exist, the name and type of the 
argument(s) will also be displayed. User can edit the argument value field. 

The Command Request Evaluation window (Figure A.5.4-4) is very similar to the Command 
Request Creation window. However, all the information display in this window is for read-only 
purpose. There are five push buttons at the bottom. Each of these buttons will be discuss in 
section A.5.4.3. 

The Command Request Rejection window (Figure A.5.4-5) allows user to edit or review the 
reject reason of a selected command request. The name of the originator and ops controller will 
be displayed. The submitted date and rejected date will also be displayed. 

The Command Request Time Selector window (Figure A.5.4-6) allows the CAC to merge the 
command request into a particular time frame of the Command Controller window. This 
window will be displayed only if the originator did not provides the actual execution time of the 
command request. 

A.5.4.2 Command Request Generation Access 

The Command Request Creation (Figure A.5.4-1) and Command Request Evaluation (Figure 
A.5.4-4) windows can be accessed from the Command Request Status window. This tool is only 
accessible by authorized personnel that have been granted access to create or evaluate command 
requests. 

The Command Request Procedure Selection window (Figure A.5.4-2) and the Command 
Request Argument Editor window (Figure A.5.4-3) can be accessed by the Command Request 
Creation window. 

The Command Request Rejection window (Figure A.5.4-5) can be accessed by selecting the 
'Reject' button of the Command Request Evaluation window. 

The Command Request Time Selector window (Figure A.5.4-6) can be accessed by selecting the 
'Merge' button of the Command Request Evaluation window. 

A.5.4.3 Command Request Generation Input 

The Command Request Generation provides the user with standard editing capabilities through a 
combination of keyboard and mouse input. The keyboard is used primarily to edit the subject, 
and instruction fields. The mouse is used to position the cursor within the window contents, to 
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perform standard Motif selection operations, and to select options from the pull-down menus and 
push buttons. 

The Command Request Creation window (Figure A.5.4-1) allow authorized user to create a 
command request. The subject field allows user to define the purpose of the command request. 
The instruction field allows user to provide specific instruction or miscellaneous information for 
the FOT to review. 

The Select Procedure button will display the Command Request Procedure Selection window 
(Figure A.5.4-2). 

The Delete button will remove the selected procedure in the selected procedure list. 

The Select Time button will display a single time selector. This button will be disabled if no 
procedure is selected in the Selected Procedure list area. 

The Argument Editor button will display the Command Request Argument Editor window 
(Figure A.5.4-3) for a selected procedure. 

The Procedure Builder button will display the Procedure Builder. 

The Send button allows an authorized user to send a command request. 

The Cancel button will dismiss the Command Request Creation window without making any 
change or update to the selected command request. 

The Help button contains an option that provides context-sensitive help for the user. Section 
A.2.7 contains further information about the Help utility. 

The Command Request Procedure Selection window (Figure A.5.4-2) allows the authorized user 
to selected procedure(s) from a list of available procedures list. There are two type of procedure 
available: local, or operational. User can selected the procedure type from the filter pull-down 
menu. 

The Procedure list area will list all the procedures available. The toggle button on the left of 
each procedure identifies whether the procedure has be selected or not. 

The Select All button will turn on all the toggle button in the procedures list. 

The Clear All button will turn off all the toggle button in the procedures list. 

The View button will display a selected procedure (which is being highlight) in the Procedure 
Builder. 

The OK button will dismiss the Command Request Procedure Selection window with the current 
selected procedure in the procedure list. 

The Cancel button will dismiss the Command Request Procedure Selection window without 
making any change to the selected procedure list. 

The Help button contains an option that provides context-sensitive help for the user. Section 
A.2.7 contains further information about the Help utility. 
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The Command Request Argument Editor window (Figure A.5.4-3) allows the authorized user to 
edit the argument value of a selected procedure. If argument(s) is expected for a procedure, user 
can edit the argument value field in the window. 

The OK button will dismiss the Command Request Argument Editor window with the current 
argument(s) value. 

The Cancel button will dismiss the Command Request Argument Editor window without making 
any change or update to the selected command request. 

The Help button contains an option that provides context-sensitive help for the user. Section 
A.2.7 contains further information about the Help utility. 

The Command Request Evaluation window (Figure A.5.4-4) allows the Ops Controller to reject 
or accept a command request. All the command request information is displayed in this window 
without any editing capability. 

The View button will display a selected procedure in the Procedure Builder. 

The Accept button allows the Ops Controller to accept the command request. 

The Reject button allows the Ops Controller to reject the command request. It will display a 
Command Request Rejection window (Figure A.5.4-5). 

The Merge button will allow the CAC to merge the command request into the ground script. 

The Cancel button will dismiss the Command Request Evaluation window without making any 
change or update to the selected command request. 

The Help button contains an option that provides context-sensitive help for the user. Section 
A.2.7 contains further information about the Help utility. 

The Command Request Rejection window (Figure A.5.4-5) allows the Ops Controller to edit the 
rejection reason of a command request. 

The OK button allows will dismiss the Command Request Rejection window with a reject reason 
of a selected command request. 

The Cancel button will dismiss the Command Request Rejection window without making any 
change or update to the selected command request. 

The Help button contains an option that provides context-sensitive help for the user. Section 
A.2.7 contains further information about the Help utility. 

The Command Request Time Selector window (Figure A.5.4-6) allows the CAC to merge the 
command request into the Command Controller at certain time. This window is displayed only 
when the originator did not provide any execution time for the command request. The CAC can 
select either to merge the command request into the command controller by an actual time, or by 
the cursor position in the command controller. 

The Select Time button will display a single time selector. 
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The OK button allows will dismiss the Command Request Rejection window with a reject reason 
of a selected command request. 

The Cancel button will dismiss the Command Request Rejection window without making any 
change or update to the selected command request. 

The Help button contains an option that provides context-sensitive help for the user. Section 
A.2.7 contains further information about the Help utility. 

A.5.4.4 Command Request Generation Output 

The Command Request Generation will create or update a command request. The status of the 
command request will display at the Command Request Status window (refer to section A.5.5). 

A.5.5 Command Request Status 

Command Request Status 

OriginatorID 
Request Date 

Submitted
Date 
Acted Subject 

SC 
Status 

Help Cancel Evaluate Create 

10/01/95 
10/04/95

AM1 1 
2 10/02/05 AM1 rejected 

pending proc 5 & 7
proc 3 

R. Moore 

: 
: 

ID 
Sub-
system 

MISR 
MISR 

Refresh 

R. Moore 

10/11/953 10/10/05 AM1 accepted proc 12 MISR A. Casey 

Figure A.5.5-1. Command Request Status Window 

A.5.5.1 Command Request Status Usage 

The Command Request Status is used to display command request status. This tool allows an 
authorized user to create, evaluate or merge a command request.. 

The Command Request Status includes the command request status area. This area contains the 
request ID, request subject, originator name, date submitted, date acted, spacecraft ID, subsystem 
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ID, and status. At the bottom there are five push buttons. Each of these buttons is described in 
Section A.5.5.3 below. 

A.5.5.2 Command Request Status Access 

The Command Request Status is accessed from the Tools menu on the Control Window. This 
tool is only accessible by authorized personnel that have been granted access to create and 
submit command requests to the Flight Operations Team (FOT). In the IST, the authorized users 
are the users who receive authorization from the PI/TL. In EOC, the authorized users are the 
users who receive authorization from the EOC Manager. The Ops Controller is authorized to 
evaluate the request. Requests that are accepted are merged by the Command Activity Controller 
(CAC). 

A.5.5.3 Command Request Status Input 

The Command Request Status provides the user with standard editing capabilities through mouse 
input. The mouse is used to perform standard Motif selection operations, to select a request from 
the command request area, and to select push buttons. 

The Create button will activate the Command Request Generation window. 

The Evaluate button will activate the Command Request Evaluation window for a selected 
command request. 

The Refresh button will refresh the Command Request Status window. 

The Cancel button will dismiss the Command Request Status window. 

The Help button contains an option that provides context-sensitive help for the user. Section 
A.2.7 contains further information about the Help utility. 

A.5.5.4 Command Request Status Output 

The Command Request Status will display command request information and status. 
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A.6.1 Alphanumeric Windows 

Figure A.6.1-1 Alphanumeric windows (sample) 
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A.6.1.1 Alphanumeric Window Usage 

An Alphanumeric window is used for displaying to EOC users the telemetries associated with 
spacecrafts' subsystems and instruments at real-time. This display may also include the unit of 
measurement, the converted value, and a set of flags corresponding to each mnemonic or 
descriptor. 

A.6.1.2 Alphanumeric Window Access 

An Alphanumeric window can be accessed from an user input command or any of the push 
buttons from the Control Window; or from another alphanumeric window. 

A.6.1.3 Alphanumeric Window Input 

An Alphanumeric window does not require any user input data. 

A.6.1.4 Alphanumeric Window Output 

An Alphanumeric window allows the user to: 

• Generate graphs analyzing the real-time telemetries 

• Generate graphs or spreadsheets analyzing the historical telemetries 

• Change the display of the descriptor label to its corresponding mnemonic label 

• Change the display of the mnemonic label to its corresponding descriptor label 

• 	 Change the display of the converted value into various formats: English units, raw 
decimal, or raw hexadecimal 

• Display a collection of selected telemetries onto a new alphanumeric window 
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A.6.5 Command Request Status 

Command Request Status 

OriginatorID 
Request Date 

Submitted 
Date 
ActedSubject 

SC 
Status 

HelpCancelEvaluateCreate 

10/01/95 
10/04/95 

AM11 
2 10/02/05 AM1 rejected 

pendingproc 5 & 7 
proc 3 

R. Moore 

: 
: 

ID 
Sub­
system 

MISR 
MISR 

Refresh 

R. Moore 

10/11/953 10/10/05 AM1 acceptedproc 12 MISRA. Casey 

Figure A.6.5-1. Command Request Status Window 

A.6.5.1 Command Request Status Usage 

The Command Request Status is used to display command request status. This tool allows an 
authorized user to create, evaluate or merge a command request.. 

The Command Request Status includes the command request status area. This area contains the 
request ID, request subject, originator name, date submitted, date acted, spacecraft ID, subsystem 
ID, and status. At the bottom there are five push buttons. Each of these buttons is described in 
Section A.6.5.3 below. 

A.6.5.2 Command Request Status Access 

The Command Request Status is accessed from the Tools menu on the Control Window. This 
tool is only accessible by authorized personnel that have been granted access to create and 
submit command requests to the Flight Operations Team (FOT). In the IST, the authorized users 
are the users who receive authorization from the PI/TL. In EOC, the authorized users are the 
users who receive authorization from the EOC Manager. The Ops Controller is authorized to 
evaluate the request. Requests that are accepted are merged by the Command Activity Controller 
(CAC). 

A-130 605-CD-003-001




A.6.5.3 Command Request Status Input 

The Command Request Status provides the user with standard editing capabilities through mouse 
input. The mouse is used to perform standard Motif selection operations, to select a request from 
the command request area, and to select push buttons. 

The Create button will activate the Command Request Generation window. 

The Evaluate button will activate the Command Request Evaluation window for a selected 
command request. 

The Refresh button will refresh the Command Request Status window. 

The Cancel button will dismiss the Command Request Status window. 

The Help button contains an option that provides context-sensitive help for the user. Section 
A.2.7 contains further information about the Help utility. 

A.6.5.4 Command Request Status Output 

The Command Request Status will display command request information and status. 

A.6.1 Alphanumeric Windows 
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Figure A.6.1-1 Alphanumeric windows (sample) 

A.6.1.1 Alphanumeric Window Usage 

An Alphanumeric window is used for displaying to EOC users the telemetries associated with 
spacecrafts' subsystems and instruments at real-time. This display may also include the unit of 
measurement, the converted value, and a set of flags corresponding to each mnemonic or 
descriptor. 

A.6.1.2 Alphanumeric Window Access 

An Alphanumeric window can be accessed from an user input command or any of the push 
buttons from the Control Window; or from another alphanumeric window. 

A.6.1.3 Alphanumeric Window Input 

An Alphanumeric window does not require any user input data. 

A.6.1.3 Alphanumeric Window Output 

An Alphanumeric window allows the user to: 

• Generate graphs analyzing the real-time telemetries 

• Generate graphs or spreadsheets analyzing the historical telemetries 
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• Change the display of the descriptor label to its corresponding mnemonic label 

• Change the display of the mnemonic label to its corresponding descriptor label 

• 	 Change the display of the converted value into various formats: English units, raw 
decimal, or raw hexadecimal 

• Display a collection of selected telemetries onto a new alphanumeric window 

A.6.2.1 Graph 
MiCamGraph 

MICPSCAI Min: 242.1875 Present: 250.0000 Max: 259.7656 

150 

200 

250 

300 

350 

14:37 14:38 14:39 14:40 14:41 

MICPSAI 

MITECAAT 

Start Time 95/097 14:00:00 Stop Time 95/097 15:00:00 

Figure A.6.2.1-1. Graph Window 

A.6.2.1.1 Graph Usage 

The graph will be either a real-time or a historical graph displaying up to six telemetry 
parameters in X vs. Y line format. The real-time graph will update at a user selectable rate from 1 
to 60 seconds. The user will be able to interactively modify the view of the graph with the ability 
to change graph attributes such as the title, axis labels, axis granularity, grid granularity, 
parameter symbols and line style. 

A.6.2.1.2 Graph Access 
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The graph can be accessed from a predefined dynamic page which contains graph display items, 
from the Quick Analysis window, or from the Analysis Request window which can request a 
historical graph window. 

A.6.2.1.3 Graph Input 

The dynamic page with only one graph widget will contains graph widget, scroll bar, labels 
showing start/stop time, and labels showing parameter minimum/current/maximum value. 

The right mouse button is used to pop-up a menu to choose an operation to be executed on the 
graph. These operations are described as follow: 

To change the update mode for real-time graph: the user can switch between latest value mode 
(normal mode) and all values mode (strip chart mode). 

To change the update rate for real-time graph: the user can change the update rate from 1-60 
seconds. 

To change the graph attributes: the user can change graph attributes, such as the parameter line 
style attributes, the grid line attributes, the high and low, red and yellow limit line attributes, the 
axis and the legend attributes. 

To pause/resume the real-time graph: the user can pause the real-time graph and resume the real­
time graph from the pop-up menu. User can zoom in/out the graph and return to default graph 
display (before zoom in/out). 

A.6.2.1.4 Graph Output 
The graph outputs an encapsulated postscript file of the graph widget itself. 
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A.6.2.2 Graph Format Dialog 

Close Help 

Graph Format Dialog 

Top Graph 1 2 

Axis Header/Footer 

Line Styles 

Graph Legend 

Labels 

Figure A.6.2.2-1. Graph Format Dialog 
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Graph Axis Properties 
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Figure A.6.2.2-2. Graph Axis Properties 
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Graph Line Style 
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Figure A.6.2.2-3. Graph Line Style 
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Graph Area Properties 
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Figure A.6.2.2-4. Graph Area Properties 
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Graph Header/Footer Properties 
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Figure A.6.2.2-5. Graph Header/Footer Properties 
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Figure A.6.2.2-6. Graph Label Properties 
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Graph Legend Properties 

Close Help 

Position : 

Colors : 
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Foreground 
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Border Width: 

Border Type : 
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Plain 3D Out Etched Out 

Shadow 
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Y : Default 

Vertical Horizontal 

Show Legend 

Orientation : 
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Figure A.6.2.2-7. Graph Legend Properties 

A.6.2.2.1 Graph Format Dialog Usage 

The graph format dialog allows the user to change the format attributes of the associated graph. 
Attributes which are allowed to be modified by the user include the axis properties, the data line 
styles, the graph area properties, the header and footer properties, the label strings, and the 
legend properties. 

A-140 605-CD-003-001




A.6.2.2.2 Graph Format Dialog Access 
The graph format dialog can be accessed from a predefined dynamic page which contains graph 
display items, from the Quick Analysis window, or from the Analysis Request window which 
can request a historical graph window. 

A.6.2.2.3 Graph Format Dialog Input 

The graph format dialog contains seven windows, Figure A.6.2.2-1 graph format dialog, Figure 
A.6.2.2-2 graph axis properties, Figure A.6.2.2-3 graph line style, Figure A.6.2.2-4 graph area 
properties, Figure A.6.2.2-5 graph header/footer properties, Figure A.6.2.2-6 graph label 
properties, and Figure A.6.2.2-7 graph legend properties. Details description of each figure are 
followed. 

The Graph Format Dialog (Figure A.6.2.2-1) : 

This is the dialog that will be opened when a user wants to specify/change the format of the 
graph from the Quick Analysis window, the Analysis Request window, or from a dynamic page 
which contains graph display items. The graph format dialog contains the following components: 

•	 Top graph toggle buttons : When a combination graph has been defined, the toggles 
select which dataset to display in the front. 

• Axis button : To invoke the graph axis properties window. 

• Line Styles button : To invoke the graph line styles window. 

• Graph button : To invoke the graph area properties window. 

• Header/Footer button : To invoke the header/footer properties window. 

• Labels button : To invoke the graph label properties window. 

• Legend button : To invoke the graph legend properties window. 

• Close button : To close the graph format dialog. 

• Help button : To invoke the help utility. 

The Graph Axis Properties Window (Figure A.6.2.2-2) : 

The graph axis properties is used to control the X, Y, and Y2 axis properties. The axis and data 
minimum/maximum, precision, and numbering/ticking increments have default values based on 
the data attached to the graph and the size of the graph area. 

Specific values may be substituted for default values by de-selecting the Default toggle and 
entering a new value. To return to using the default values, select the Default toggle. 

X Axis, Y Axis, and Y2 Axis toggles at the top of the window select which axis the following 
Axis Specific control elements apply to : 

• The Show Axis toggle causes the axis to be shown on the graph. 

• The Logarithmic toggle changes the axis into a logarithmic axis. 
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•	 The Data Min numeric text field specifies the low-end of the dataset. Data points with 
values lower then the specified value will not display. 

•	 The Data Max numeric text field specifies the high-end of the dataset. Data points with 
values greater than the specified value will not display. 

•	 The Axis Min numeric text field specifies the low-end of the axis itself. Data points with 
values lower than the specified value will not display. 

•	 The Axis Max numeric text field specifies the high-end of the axis itself. Data points with 
values higher than the specified value will not display. 

•	 The Precision numeric text field specifies how many digits of precision should be used 
for the axis annotation. 

• The Origin numeric text field specifies where one axis crosses the other axis. 

•	 The Numeric Increment numeric text field specifies the increment between numeric 
annotations on the axis. 

•	 The Tick Increment numeric text field specifies the increment between tick marks on the 
axis. 

•	 The Grid Increment numeric text field specifies the increment between grid marks on the 
axis. Set the Grid Increment to 0.0 and un-check the Default check-box to turn the grid 
off. 

• The Title text field specifies the axis title. 

•	 The Title Rotation and Annotation Rotation toggles specify how the axis title or 
annotation text should be rotated. 

•	 The Annotation Placement toggle specifies the placement of the annotation and title. 
"Auto" causes determining placement automatically. "Minimum", "Maximum", and 
"Origin" place the annotation/title at the axis minimum, axis maximum, or origin 
respectively. 

•	 The Origin Placement toggle specifies the placement of origins. "Auto" causes 
determining placement automatically. "Minimum", "Maximum", and "Zero" place the 
origin at the axis minimum, axis maximum, or zero point respectively. 

•	 The Grid Style shortcut button will popup the Line Style window for editing the Grid 
Line Style. 

• The Close button will close the Graph Axis Properties window. 

• The Help button will invoke the help utility. 

The Graph Line Style Window (Figure A.6.2.2-3) : 

This window is used to specify the color and size of lines, points for the data representation in a 
graph (and the second graph in a combination graph), and the X and Y grid-lines. It is composed 
of the following items : 

A-142 605-CD-003-001




•	 The Line Styles toggle determines which data styles are being edited. When set to Graph1 
or Graph2, the line styles properties corresponding to the data in the first or second graph 
in a combination graph are displayed. When set to X-Grid or Y-Grid, it displays data 
style properties of the appropriate grid line. 

•	 The User Default toggle causes the default data style properties to be used. Specific data 
styles cannot be selected if this item is selected. 

•	 The Line Index numeric text field only has meaning when the line style properties of a 
graph are being displayed. Each set of data has its own line style properties. The index 
identifies the set of data within the attached data. 

• The Line width numeric text item specifies the line thickness. 

• The Point Size numeric text item specifies the relative size of points. 

• The Line Pattern scrolling list specifies the line pattern. 

•	 The Point Style scrolling list specifies the point style used to identify the location of data 
points. 

•	 The Line Color text item and button specifies the color used when drawing lines. The 
user may enter a color directly, or click the button to bring up the Color Chooser. 

•	 The Point Color text item and button specifies the color used when drawing points. The 
user may enter a color directly, or click the button to bring up the Color Chooser. 

• The Close button will close the Graph Line Style window. 

• The Help button will invoke the help utility. 

The Graph Area Properties Window (Figure A.6.2.2-4) : 

The Graph Area Properties window is used to determine the position, size, color (off-line), and 
border style of the graph area within the graph window. 

The Graph calculates a default position and size depending on the size of the other graph areas 
(the header, footer, and legend areas), and the current size of the window. By default, the graph 
always positions the graph area in the largest remaining rectangular area available once the 
header, footer, and legend have been sized and positioned. 

Specific values may be substituted for default values by deselecting the Default toggle and 
entering a new value. To use the default values, select the Default toggle. 

The Graph Area Properties window is composed of the following elements : 

• The Border Type toggle determines the graph border style. 

• The Border width numeric text item determines the width of the border. 

•	 The X and Y numeric position selections determine the top-left corner of the graph area, 
measured relative to the window's top-left corner. 

•	 The Width and Height numeric position selections determine the graph area's width and 
height. 
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•	 The Background and Foreground Color text fields and buttons specify the background 
and foreground colors. The user may enter a color directory or click the button to bring 
up the Color Chooser. This function is only available for off-line graph. 

• The Close button will close the Graph Area Properties window. 

• The Help button will invoke the help utility. 

The Graph Header/Footer Properties Window (Figure A.6.2.2-5) : 

The Header/Footer properties window is used to determine the text which appears in the header 
and footer areas. It also determines the header/footer area border, positioning and colors. It is 
composed of the following elements : 

• The Strings scroll-list modifies the header/footer text. 

• The Border Type toggle determines the header/footer border style. 

• The Border Width numeric text item determines the width of the border. 

•	 The X and Y numeric position selections determine the coordinate of the top-left corner 
of the header/footer area, measured relative to the window's top-left corner. 

•	 The Background and Foreground Color text fields and buttons specify the background 
and foreground colors. The user may enter a color directory or click the button to bring 
up the Color Chooser. 

• The Close button will close the Graph Axis Properties window. 

• The Help button will invoke the help utility. 

The Graph Label Properties Window (Figure A.6.2.2-6) : 

The nth set-label is used to annotate the nth set in the attached data. The Label Properties 
window consists of the following element : 

• The Labels scroll-list and apply button defines or modifies the text of each label. 

• The Close button will close the Graph Axis Properties window. 

• The Help button will invoke the help utility. 

The Graph Legend Properties Window (Figure A.6.2.2-7) : 

The Legend Properties window is used to specify how the legend will appear, and its position, 
border and color. It is composed of the following elements: 

• The Show Legend toggle determines whether or not the legend will be displayed. 

•	 The Orientation toggle specifies whether the legend should be laid out vertically or 
horizontally. 

•	 The Anchor toggle specifies the general position of the legend relative to the graph 
window. The anchor specification only has effect when at least one of the positioning 
resources (X, Y) specified below is set to Default. 
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• The Border Type toggle determines the legend border style. 

• The Border Width numeric text item determines the width of the border. 

•	 The X and Y numeric position sliders determine the coordinate of the top-left corner of 
the legend area, measured relative to the window's top-left corner. The default legend 
position depends on the current size of the window and the Anchor setting. Specific 
values may be substituted for default values by deselecting the Default toggle, and 
entering a new value. To use the default values, select the Default toggle. 

•	 The Background and Foreground Color text fields and buttons specify the background 
and foreground colors. The user may enter a color directly or click the button to bring up 
the Color Chooser. 

• The Labels shortcut button exposes the Label Properties window. 

• The Close button will close the Graph Axis Properties window. 

• The Help button will invoke the help utility. 

A.6.2.2.4 Graph Format Dialog Output 

None. 
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A.6.3.1 Table 

TABLE 

Start Time 95/097 21:14:28 Stop Time 95/097 21:14:43 

Time 

95/097 21:14:28 

95/097 21:14:33 

95/097 21:14:38 

95/097 21:14:43 

MITECAAT MITECANT MITECBAT 

10.1406 

9.2812 

10.1406 

10.1406 

10.1406 10.1406 

8.9375 10.8281 

10.14068.4219 

MITECAFT 

10.1406 

9.2832 

10.1406 

8.0781 10.1406 10.1406 

HR 

HR 

LR 

S 

Q 

Figure A.6.3.1-1. Table Window 

A.6.3.1.1 Table Usage 

The table will be either a real-time or a historical table displaying up to fifty columns of 
telemetry parameters values and their associated times. The real-time table will update at a user 
selectable rate from 1 to 60 seconds. The telemetry parameter values will be raw values, decoded 
values, or converted values and displayed in the user selectable format such as the formatted, 
octal, hexadecimal, and binary. 

A.6.3.1.2 Table Access 

The table can be accessed from a predefined dynamic page which contains table display items, 
from Quick Analysis window, or from Analysis Request window which requests a historical 
table window. 

A.6.3.1.3 Table Input 
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The dynamic page with table widget will contain a table widget, vertical and horizontal scroll 
bars, labels showing start/stop time of the table, and the column labels. 

The right mouse button is used to pop-up a menu to choose an operation to be executed on the 
table. These operations are described as follow: 

To change the update mode for a real-time table: the user can switch between latest value mode 
(normal mode) and all values mode. 

To change the update rate for a real-time table: the user can change the update rate from 1-60 
seconds. 

To change the column labels: the user can switch between displaying parameter mnemonics as 
column labels or displaying parameter descriptors as column labels. 

To change the parameter data type: the user can select the parameter data type, such as 
displaying the raw data, decoded data, or converted parameter data. 

To change the parameter display type: the user can select the parameter display type, such as 
displaying the values in formatted, octal, hexadecimal, or binary. 

To change the table attributes: the user can change the table attributes, such as the row/column 
width/height, colors, margin width/height, and border type/thickness. 

To pause/resume the real-time table: the user can pause the real-time table and resume the real­
time table. 

A.6.3.1.4 Table Output 

The table outputs an encapsulated postscript file of the table widget itself. 

The table can output table data to a carry out format file. 
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A.6.3.2 Telemetry Table Format Dialog 
Telemetry Table Format Dialog 

OK HelpApply Cancel 

ALL -> -> <­ <- ALL 

Available Columns 

micpsaai 
micpsaai flags 
micpsafi 

micpsafi flags 
micpsani 
micpsani flags 
micpsbai 
micpsbai flags 
micpsbfi 

micpsbfi flags 
micpscai 
micpscai flags 

micpscfi 
micpscfi flags 

Display Columns 

Find 

Format applies to All Row Column 

Text Alignment : 

: 

Begin Center End 

Border 

Side 

Type 

Thickness 

: 

: 

: 2 

None 3dIn EtchedIn 

Left Right Top Bottom All None 

EtchedOut3dOut 

1 1 

Colored Values : Yes No 

Figure A.6.3.2-1. Telemetry Table Format Dialog 

A.6.3.2.1 Telemetry Table Format Dialog Usage 

The Telemetry Table Format Dialog allows the user to change the format attributes of the 
telemetry table. Attributes which are allowed to be modified by the user include the text 
alignment, the cell border side, type, thickness, colored cell telemetry values, and 
hiding/displaying the telemetry values/flags columns. The user can apply the telemetry attribute 
changes to the whole table, to a specified row, or to a specified column. 

A.6.3.2.2 Telemetry Table Format Dialog Access 
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The Telemetry Table Format Dialog can be accessed from the Analysis Request window, or from 
the Dynamic page which contains the telemetry table using the right mouse button pop up menu. 

A.6.3.2.3 Telemetry Table Format Dialog Input 

The Telemetry Table Format Dialog is used to change the format attributes of the telemetry table. 
The attributes that can be modified are described as follow: 

Some attributes such as the text alignment, the cell border side, type can be modified and applied 
to the whole table, to a specified row, or to a specified column. The border width and the colored 
cell telemetry values are specified for the entire table. 

The Format applies radio buttons: 

• All - apply the attributes to the whole table 

• Row - apply the attributes to one row only. The user needs to enter the row number. 

•	 Column - apply the attributes to one column only. The user needs to enter the column 
number. 

The Text Alignment radio buttons : 

• Begin - The text aligns to the beginning of the cell. 

• Center - The text aligns to the center of the cell. 

• End - The text aligns to the end of the cell. 

The cell border attributes : 

•	 The border side : Specifies the sides of a cell that display the border type. The choices 
will be -- left, right, top, bottom, all, none. 

•	 The border type : Specifies the type of border drawn around cells. The choices will be -­
none, 3dIn, 3dOut, EtchedIn, EtchedOut. 

•	 The border thickness : The width of the borders around the cells. This attribute applies to 
the entire table. 

The colored values radio buttons: 

•	 Yes : Turns on the color capability, i.e. when the telemetry value is not in the normal 
range, it will display different colors (High Red/Low Red, High Yellow/Low Yellow). 

•	 No : Turns off the color capability, i.e. all telemetry values are displayed using the same 
foreground color. 

The double selection list box : 

Items in the display columns will be displayed and items in the available columns will be hidden. 
The user can user this double selection list box to display/hide telemetry value and/or telemetry 
flags. 

Four push buttons : 
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• OK : Apply the changes and close the Telemetry Table Format dialog. 

• Apply : Apply the changes. 

• Cancel : Cancel the changes and close the Telemetry Table Format dialog. 

• Help : Invoke the context sensitive help utility. 

A.6.3.2.4 Telemetry Table Format Dialog Output 
None 

A.6.4.1 Schematic Parts 

A.6.4.1.1 Schematic Part Usage 

Schematic parts are assigned to a dynamic page by the Display Builder. A schematic part may 
also be associated with a parameter, which will cause the part to update its color and/or its 
appearance. 

A.6.4.1.2 Schematic Part Access 

Schematic parts may be accessed as part of a dynamic page. 

A.6.4.1.4 Schematic Part Input 

Schematic parts do not support user input. 

A.6.4.1.5 Schematic Part Output 

Schematic parts will display themselves according to their settings as specified within Display 
Builder. If a part is associated with a parameter, it will also exhibit behavior as described below: 

• Icons will display a different image (pixmap) depending on the value of the parameter. 

•	 Lines, points, arcs, polygons, rectangles, squares, ellipses, circles and arcs will change 
color according to the parameter's flags (e.g., High Yellow). 

•	 Rectangles, squares, ellipses, and circles may also be filled to represent the value of the 
parameter relative to some predefined scale. 

A.6.5.1 Combined Window 

A.6.5.1.1 Combined Window 

The combined window is a dynamic page that contains a variety of display item types. All 
dynamic pages are capable of containing alphanumerics, graphs, tables, and schematics. Figure 
A.6.5-1 shows a dynamic page containing a graph, alphanumericdisplay items, and schematic 
parts. 
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Figure A.6.5-1 Combined Window (sample) 

A.6.5.1.2 Combined Window Usage 

A combined window may be accessed via the Control Window (see Section A.1.8). 
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A.6.5.1.4 Combined Window Input 
A combined window's components will accept input as described in sections A.6.1-2.7.4. 

A.6.5.1.5 Combined Window Output 

A combined window's components will produce output as described in sections A.6.1-2.7.4. 

A.6.6.1. Telemetry Attributes 

A.6.6.1.1 Telemetry Attributes Usage 

The telemetry attributes will display a column of telemetry parameter mnemonics and respective 
columns of associated data in a tabular format. The data displayed in the Telemetry Attributes 
will come from the specified operational data base (ODB) in the off-line mode or come from the 
operational data base (ODB) and the DeCom process in the real-time mode. The data will 
include the valid discrete states, the high/low limit values, the delta limits, the parameter 
conversion coefficients etc. 

Mnemonic Parameter Type Low Red Low Yellow 

MITECAAT Analog -30.0000 -28.5000 

MITECCAFT -31.0000 -15.5000 

MITECDAT -32.0000 -29.0000 

Telemetry Attributes 

Analog 

Analog 

MIPROC Discrete 

Figure A.6.6.1-1. Telemetry Attributes 
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A.6.6.1.2 Telemetry Attributes Access 

The Telemetry Attributes can be accessed from several windows such as the Quick Analysis 
window, the Analysis Request window, and the Dynamic page using the right mouse button pop 
up menu. 

A.6.6.1.3 Telemetry Attributes Input 

The Telemetry Attributes is used for displaying telemetry parameter attribute information. The 
user can use the horizontal scrollbar or the vertical scrollbar to adjust the visible area to see other 
attribute data contained in the window. 

A.6.6.1.4 Telemetry Attributes Output 

The Telemetry Attributes outputs an encapsulated postscript file of the table widget itself. 
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A.6.6.2 Telemetry Attributes Format Dialog 
Telemetry Attributes Format Dialog 

OK HelpApply Cancel 

ALL -> -> <­ <- ALL 

Available Columns 

parameter type 
telemetry identifier 
DN/EU indicator 

red low limit 
yellow low limit 
yellow high limit 
red high limit 
limit switch mnemonic 
minimum switch value 

maximum switch value 
delta limit value 

minimum range value 
maximum range value 
discrete state text 
result units 
computation rate 

Display Columns 

Find 

Format applies to All Row Column 

Text Alignment : 

: 

Begin Center End 

Border 

Side 

Type 

Thickness 

: 

: 

: 2 

None 3dIn EtchedIn 

Left Right Top Bottom All None 

EtchedOut3dOut 

1 1 

Figure A.6.6.2-1. Telemetry Attributes Format Dialog 

A.6.6.2.1 Telemetry Attributes Format Dialog Usage 

The telemetry attributes Format Dialog allows the user to change the format attributes. Attributes 
which are allowed to be modified by the user include the text alignment, the cell border side, 
type, thickness, and hiding/displaying the telemetry attribute columns. The user can apply the 
telemetry attribute changes to the whole table, to a specified row, or to a specified column. 
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A.6.6.2.2 Telemetry Attributes Format Dialog Access 

The Telemetry Attributes Format Dialog can be accessed from the Analysis Request window, or 
from the Dynamic page which contains the telemetry attributes using the right mouse button pop 
up menu. 

A.6.6.2.3 Telemetry Attributes Format Dialog Input 

The Telemetry Attributes Format Dialog is used to change the format attributes of the telemetry 
attributes. The attributes that can be modified are described as follow: 

Some attributes such as the text alignment, the cell border side, type can be modified and applied 
to the whole table, to a specified row, or to a specified column. The border width is specified for 
the entire table. 

The Format applies radio buttons: 

• All - apply the attributes to the whole table 

• Row - apply the attributes to one row only. The user needs to enter the row number. 

•	 Column - apply the attributes to one column only. The user needs to enter the column 
number. 

The Text Alignment radio buttons : 

• Begin - The text aligns to the beginning of the cell. 

• Center - The text aligns to the center of the cell. 

• End - The text aligns to the end of the cell. 

The cell border attributes : 

•	 The border side : Specifies the sides of a cell that display the border type. The choices 
will be -- left, right, top, bottom, all, none. 

•	 The border type : Specifies the type of border drawn around cells. The choices will be -­
none, 3dIn, 3dOut, EtchedIn, EtchedOut. 

•	 The border thickness : The width of the borders around the cells. This attribute applies to 
the entire table. 

The double selection list box : 

Items in the display columns will be displayed and items in the available columns will be hidden. 
The user can user this double selection list box to display/hide telemetry attributes. 

Four push buttons : 

• OK : Apply the changes and close the telemetry attributes format dialog. 

• Apply : Apply the changes. 

• Cancel : Cancel the changes and close the telemetry attributes format dialog. 
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• Help : Invoke the context sensitive help utility. 

A.6.6.2.4 Telemetry Attributes Format Dialog Output 

None 

A.6.7 Status Window 

A.6.7.1 Status Window Usage 

The Status Window is used for displaying to EOC users the status of the spacecraft and 
instruments from which real-time telemetry data is sent. The Status Window contains the 
following indicators: 

UTC - ground station time 

S/C - spacecraft time 

Quality - quality of data being sent 

Format - data format type 

Rev - orbit identification number 

TLM Rate - telemetry data transfer rate 

Data Source - data server 

Master/Major - master and major frame counters 

A.6.7.2 Status Window Access 

The Status Window is accessed when the Control Window is accessed. 

A.6.7.3 Status Window Input 

The Status Window usage does not require user input. 

A.6.7.4 Status Window Output 

The Status Window usage does not generate any output. 
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A.6.8 SSR Analysis 

SSR Analysis 

PB Clock Present: On 
Memory Power Status: 

Built in Test Ind: 
Low Power Ind: 

On 

On 
On 

Memory Config Ind: 
Temperature: 

Overwrite Status: 
Watch Dog Timer: 

On 
10 C 

Off 
Off 

Replay: 
Playback: 

Instant Replay: 
Record: 
Standby: 

On 
Off 

Off 
Off 
Off 

Playback Counter Record Counter 

LRS 
MISR 
MODIS 

ASTER 
TRASH 

000 
000 
630 

000 
000 

820 
560 
000 

620 
700 

Problems/Solutions 

95/193/18:14:00.857 

95/193/18:14:01.030 

95/193/18:17:20.920 

95/193/18:17:22.532 

SSR Buffer Counters 

SSR Health and Safety 

Forward link has failed: xxxxxxxxxx LCP 

Send a GCMR: xxxxxxxxxx LCS 

Bad data quality DRP 

Replay SSR DRS 

Figure A.6.8-1. SSR Analysis Window 

A.6.8.1 SSR Analysis Usage 

The SSR Analysis window allows the user to monitor the SSR buffer pointers, buffer status, 
playback state. Data loss recovery and RF link problems and solutions, as well as command 
requests for playbacks can be viewed. 
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A.6.8.2 SSR Analysis Access 

The SSR Analysis window can be accessed from the Tool Selector that is activated from the 
Command window. 

A.6.8.3 SSR Analysis Input 

The SSR Analysis window is read only. 

A.6.8.4 SSR Analysis Output 

The SSR Analysis window displays SSR parameters and recording and playback counters in a 
table and a graph. These portions of the display will be initiated from a file that drives a dynamic 
page. 

Data loss recovery and link problems and solutions can be viewed along with command requests 
in a scrolling list. 

Known problem/solution categories are: 

• PLC - Link Correction Problem 

• SLC - Link Correction Solution 

• PDR - Data Recovery Problem 

• SDR - Data Recovery Solution 

• SCR - Command Request Generated Solution 

If additional problem areas are defined, this list will be expanded. 

The user may snap a picture of this window. 

A.7.1 Data Source Selector 

A.7.1.1 Data Source Selector Usage 

The Data Source Selector (Figure A.7.1-1) is used by the Flight Operations Team (FOT) and 
Instrument Operations Team (IOT) members to connect dynamic telemetry displays (i.e., 
dynamic pages) to one or more established data sources (i.e., logical strings). The number of 
data sources that a display can connect to is defined when the display is created (reference the 
Display Builder in Section A.2.6). 

The Data Source Selector window consists of a Room list, a Page list, and a Data Source list. 
The Room list, located at the top of the window, contains the names of the rooms used to filter 
the items in the Page list. By default, the Room list will contain the names of the user's default 
and accessed rooms for the current session. Selecting the toggle button associated with a room 
name adds the dynamic pages defined in that room to the Page list. If the Data Source Selector is 
activated from a dynamic page, the Room list will be empty and the Page list will only contain 
the name and assigned data source of the dynamic page that activated the Data Source Selector. 
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The user may select the Additional Rooms button to activate a dialog that provides the capability 
to add the names of other defined rooms to this list. 

The Page list, located on the left half of the window below the Room list, displays the list of 
dynamic pages and assigned data source connections. The data source connection type is also 
indicated in this list. An "M" indicates a Mirrored connection, and a "T" indicates a Tailored 
connection.  Each dynamic page will have a default data source specified when it is defined by 
the Display Builder. When the page is activated, it will attempt to connect to its default data 
source. If this connection cannot be made (e.g., the data source is not active), then the data 
source is unresolved and question marks (??????) are displayed in the assigned data source 
column of the Page list. 

The Data Source list, located to the right of the Page list, displays information about each of the 
currently established data sources, or logical strings. This list includes all data sources 
established in the EOC. An asterisk (*) is used to indicate the data sources that the user is 
currently connected to.  The Page list and Data Source list are used to change the assigned data 
source of one or more pages. The mechanism to change a data source is described below in 
Section A.7.1.3.1 

A radio box is located between the Page list and the Data Source list. This radio box allows the 
user to specify the connection type when changing a data source assignment. The options are 
Default (maintain the current connection type - use mirrored for unresolved connections), 
Mirrored (connect in a mirrored mode), and Tailored (connect in a tailored mode). 

Two buttons located just below the Page list and the Data Source List allow the user to access the 
Data Source Global Switch dialog and the Data Source Parameter Display. The Data Source 
Parameter Display will include the parameters and assigned data sources contained in the pages 
selected from the Page list. 
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Data Source Selector 

Established Data Sources 

OK Apply Cancel Help 

MICAL-MIPOWER(A) 

Page Assigned Data Source/Type 

String1 - M *String1 AM1 DB013 R/T 

*String2 AM1 DB010 D-RP OPER 

*String3 AM1 DB013 R/T 

String4 AM1 DB007 S-RP OPER 

MICAL-MIPOWER(B) String5 - M 

MICAL-MIBATGRPH String2 - T 

MICAL-MIPWRGRPH String2 - T 

Rooms: MICAL 

MICAMERA 

MIANALYSIS 

MICOMMAND 

MIANALYSIS-MIPOWER String5 - M 

MIANALYSIS-MIPWRSCH ?????? 

Global Switch 

MICAMERA-MIBATTEMP String3 - M 

Parameter Assignments 

*String5 AM1 DB007 S-RP OPER 

Additional Rooms 

MIANALYSIS-MIPWRGRPH String2 - T 

Reset 

Connection Type 

Mirrored 

Tailored 

Default 

OPER 

TRNG 

Figure A.7.1-1. Data Source Selector Window 

The five buttons located along the bottom of the window allow the user to apply or cancel the 
data source assignment changes, or to receive help about this display. Each of the buttons is 
described in Section A.7.1.3.1 below. 

The Data Source Global Switch dialog (Figure A.7.1-2) may be accessed from the Data Source 
Selector to allow a global switch of all active dynamic pages from one data source to another. 
For example, a user may use this capability to switch all active pages connected to logical string 
"String1", a real-time string not currently active, to logical string "String2", a replay string 
currently in progress. 
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Data Source Global Switch 

New Assignment 

OK Apply Cancel Help 
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String2 

String3 

String5 
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String2 

String3 
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String5 

Mirrored 

?????? 

Connection Type 
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Figure A.7.1-2. Data Source Global Switch Window 

The Data Source Global Switch dialog contains two scrolling lists. On the left portion of the 
dialog window is a list of the assigned data sources of all active pages (Current Assignment). 
The list on the right contains the list of all established data sources (New Assignment). 

A radio box is located between the assigned data source list and the established data source list. 
This radio box allows the user to specify the connection type when changing a data source 
assignment. The options are Default (maintain the current connection type - use mirrored for 
unresolved connections), Mirrored (connect in a mirrored mode), and Tailored (connect in a 
tailored mode). 

The four buttons located along the bottom of the dialog window allow the user to apply or cancel 
the global data source changes, or receive help about this display. Each of these buttons is 
described in Section A.7.1.3.2 below. 

The Data Source Parameter Display (Figure A.7.1-3) may also be accessed from the Data Source 
Selector. This is a read-only display that shows the data source connections for each telemetry 
parameter included in one or more selected dynamic pages. 

The Data Source Parameter Display contains two scrolling lists. The list on the left contains the 
parameters and assigned data sources. The connection type is indicated by an "M", for a 
mirrored connection, or a "T" for a tailored connection. As mentioned above, unresolved data 
source assignments are indicated with question marks (??????). The list on the right contains 
information about each of the established data sources. This list includes all data sources 
established in the EOC. An asterisk (*) is used to indicate the data sources that the user is 
currently connected to. The two buttons located along the bottom of the window allow the user 
to dismiss (Close) the window or request help (Help) about the window. 
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Figure A.7.1-3. Data Source Parameter Display Window 

A.7.1.2 Data Source Selector Access 

The Data Source Selector may be accessed by any user from either the Tools menu, located on 
the Control window (see Section A.7.1.3) or from any of the dynamic pages. 

A user activates the Data Source Selector from a dynamic page by selecting the appropriate 
option from a pop-up menu. Dynamic pages are further defined in Section A.6, Telemetry 
Displays. 

A.7.1.3 Data Source Selector Input 

A.7.1.3.1 Data Source Selector Window 

When activated from the Tool menu, the Data Source Selector's Room list will contain the list of 
default and accessed rooms (for the current session). Selecting the toggle button associated with 
a room name will add the names and assigned data sources of the pages contained in that room to 
the Page list. Deselecting a toggle button will remove the corresponding page entries from the 
Page list. If the Data Source Selector is activated from one of the dynamic pages, the Room list 
will be empty. 

The user may add the names of other defined rooms to this Room list by selecting the Additional 
Rooms button. This button activates a dialog containing the list of all rooms defined within the 
FOS. The user selects one or more names in the list and selects the OK button to update the 
Room list. Selecting Cancel dismisses the dialog window without updating the Room list. 

The user may select one or more entries in the Data Source Selector's Page list in order to switch 
the assigned data source. After selecting the pages to change, the user selects the connection 
type (default, mirrored, or tailored). By default, the connection type will remain the same as the 
current connection. Next, the user selects one of the established data sources in the Data Source 
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list. When the user selects the established data source, the assigned data source of the selected 
pages is updated in the Page list. A dollar sign ($) is prefixed to the assigned data source to 
indicate that a change is pending. The user may select the Reset button, located to right of the 
Apply button, to cancel all pending changes. The user must select either the OK or Apply 
button, located along the bottom of the window, to effect the changes. 

In cases where the parameters on a single dynamic page are assigned to multiple data sources, 
the user may wish to display these assignments by parameter. This is accomplished by selecting 
the desired pages from the Page list and then selecting the Parameter Assignments button. This 
activates the Data Source Parameter Display. 

The Global Switch button allows a user to switch the data source assignment of all pages 
assigned to a particular data source. This button activates the Data Source Global Switch dialog 
window. 

The five buttons located along the bottom of the window provide the following functions: 

OK	 apply all pending data source assignment changes and dismiss the Data Source 
Selector window. 

Apply	 apply all pending data source assignment changes. The Data Source Selector 
window remains open for subsequent changes. 

Reset cancel all pending data source assignment changes. 

Cancel	 dismiss the Data Source Selector window. All pending data source assignment 
changes are discarded. 

Help activate a help window containing information about the Data Source Selector. 

A.7.1.3.2 Data Source Global Switch Dialog Window 

The Data Source Global Switch dialog contains two lists: a Current Assignment list (currently 
assigned data sources) and a New Assignment list (established data sources). The user selects 
an item from Current Assignment list, the connection type (default, mirrored, or tailored), and an 
item from the New assignment list. By default, the new connection type will remain the same as 
the current connection type for each affected dynamic page. The user must either select OK or 
Apply to effect the change. All active pages assigned to the data source selected from the 
Current Assignment list are switched to the data source selected in the New Assignment list. 

The four buttons located along the bottom of the window provide the following functions: 

OK	 apply the changes indicated by selections in the Current Assignment and New 
Assignment lists and dismiss the Data Source Global Switch dialog window. 

Apply	 apply the changes indicated by selections in the Current Assignment and New 
Assignment lists. The Data Source Global Switch dialog window remains open 
for subsequent changes. 
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Cancel dismiss the Data Source Global Switch dialog window. Any changes that have 
not been applied are discarded. 

Help activate a help window containing information about the Data Source Global 
Switch dialog. 

A.7.1.3.3 Data Source Parameter Display Window 

The Data Source Parameter Display is a read-only display containing a list of parameters and 
their assigned data source and a list of the established data sources. An "M" is appended to the 
assigned data source identifier (e.g., String1) to indicate a Mirrored connection, and a "T" is 
appended to indicate a Tailored connection. User input to this display is limited to the following 
buttons, which are located along the bottom of the window: 

Close dismiss the Data Source Parameter Display window. 

Help activate a help window containing information about the Data Source Parameter Display 
window. 

A.7.1.4 Data Source Selector Output 

The output of the Data Source Selector is reflected in the updated data source assignments 
displayed in the Page list on the Data Source Selector window and the Parameter list on the Data 
Source Parameter Display window. The results of the data source changes will be also be 
evident in the telemetry data displayed in the affected dynamic pages. 

A.8.1 Analysis Request 

A.8.1.1 Analysis Request Usage 

The Analysis Request window is used by the user to request history data for analysis. An 
Analysis Request is the specification of telemetry parameters, time periods, sampling rate, 
statistics and/or algorithms for the generation of data. The user may specify the data to be 
displayed in several output views. The Analysis Request window provides a variety of tools for 
specifying all Analysis Request inputs. The user may also specify Standing Order requests, or 
access to the Report Generator function from the Analysis Request window. 
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Figure A.8.1-1. Analysis Request Window 

A.8.1.2 Analysis Request Access 

The Analysis Request window can be accessed from the Control Window or from the Status 
Window. If the Analysis Request window is accessed from the Status Window, the selected 
request, by default, will be displayed in the Analysis Request window. (Details on selecting 
requests from the Status Window are described in Section A.8.2) If accessed from the Control 
Window, the user will need to specify the request inputs. 

A.8.1.3 Analysis Request Input 

The Analysis Request Window allows the following inputs: 

•	 Selection of Analysis Request. The user must enter a directory path to get a list of 
available files. 

•	 Selection of request time period. This specifies the start and stop time of the history data 
to be retrieved. 
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•	 Selection of Standing Order Times. This specifies the start and stop time and activation 
time of requests that are initiated by time/orbital event. 

•	 Selection of telemetry parameters using the "Select TLM" button to access the Analysis 
Telemetry Selector. Figure A.8.1-2 shows the Analysis Telemetry Selector. It consists of 
the Selection Filter, a double scrolling list, sampling rate and statistics options. The 
Selection Filter utility provides for subsystem selections (details described in section 
A.3.2 ). Each parameter selected in the available list of parameters may have a sampling 
rate and/or statistics associated. Parameters can be selected more than once. Sampling 
Rates can be based on all data, changes only data or data for every Nth sample where N 
is an Integer. Statistics (Standard Deviation, or Min-Max Mean) can be system generated 
(e.g., Daily, Monthly...) or user defined where a Min-Max interval is specified. If 
statistics are associated with a selected parameter, the sampling rate will default to all 
data. If a sampling rate is associated with a selected parameter, statistics will default to 
off. (i.e., no statistics will be applied). Using the arrow "----->,<-----," buttons, the user 
may select or de-select telemetry parameters. Associated sampling rates and statistics 
flags will be displayed in the list of selected parameters. The "Find" option highlights a 
matching parameter with the unique characters entered in the "Find" text field. 

•	 Selection of product view(s) using the toggle button. Product views can be a graph, 
table, Info window or carry out format. Product view selections can be made at the time 
of the initial analysis request or may be made after the request has been completed. If 
product view selections are made after the request has been completed, output products 
are generated from the existing data produced from the initial request. (Details describing 
output views are described in section A.7) 

•	 Selection of product view format options using the "Format" button to access the Format 
Window. Format options are available for graph, table and info product views. Default 
formats are applied, if no format options are selected. (Details describing Format 
Windows are describe in section A.8.3) 

The Analysis Request window has 2 pull-down menus: File and Help. The File menu options 
include: 

New clears the analysis request window and allows the user to create an new request. 

Open	 displays a selection dialog window and allows the user to edit/read an existing 
request. 

Save allows the user to save the current analysis request. 

SaveAs. allows the user to save the current analysis request with a new request name. 

Quit exits the Analysis Request window. 

The "OK" button initiates the generation of the analysis request data and/or product views. 

The "Report Generator" button initiates the report generation tool. 

The "Cancel" button ignores any inputs and closes the Analysis Request window. 
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The "Help" button and pull-down menu provide context-sensitive help. 

A.8.1.4 Analysis Request Output 

The Analysis Request window outputs the specified output products. Output products can be a 
graph, table, Info window and/or carryout file. These products can be output to a printer, a file or 
display. 
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Figure A.8.1-2. Analysis Telemetry Selector 

A.8.2 Analysis Status Window 

A.8.2.1 Analysis Status Window Usage 

The Analysis Status window is used to view Analysis Request Status. The Status window is 
updated upon selecting the refresh button. The Analysis Status window displays the current 
status of Analysis Request in the request queue along with an estimated of percentage of the 
request that has been completed. The user may specify to prioritize, delete or view the output of 
Analysis Requests displayed in the Analysis Status window. 
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Figure A.8.2-1. Analysis Status Window 

A.8.2.2 Analysis Status Access 

The Analysis Status window can be accessed by the Control Window. 

A.8.2.3 Analysis Status Input 

The Analysis Status Window allows the following inputs: 

•	 Selection of a Analysis Request Name. The user may select an Analysis Request from 
the scrolling window for deletion, prioritizing or output products. 

•	 Selection of priority. The user may choose a priority for the Analysis Request with a 
pending status. This allows the user to manage the execution of Analysis Requests in the 
queue. 

•	 Selection of refresh. The user may update the Analysis Status display by choosing the 
refresh button. 

A.8.2.4 Analysis Status Output 

The Analysis Status window executes the Analysis Request window upon selection to view 
output products. 
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The "Apply" button activates the selection for priority, delete or output selection. 

The "Cancel" button ignores any inputs and closes the Analysis Status window. 

The "Help" button and pull-down menu provide context-sensitive help. 
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Figure A.8.1-2. Analysis Telemetry Selector 

A.8.3  Format Window 

A.8.3.1 Format Window Usage 

The Format Window is used by the Quick Analysis window and the Analysis Request Window 
to specify output view formats for display pages. Format specifications are based upon telemetry 
parameters and associated format options. There is a Format Window for the Graph, Table and 
Info output views. The Format Window shown in Figure A.8.3-1 represents the common 
elements a Format Window. The actual Format windows will be defined in Release B when 
Graph, Table and Info format options will be defined. 
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Figure A.8.3-1. Format Window 

A.8.3.2 Format Window Access 

The Format Window can be accessed from the Quick Analysis window and the Analysis Request 
Window via the "Format" button. If accessed from the Analysis Request Window, the Format 
window will, by default, display the telemetry parameters and start/stop times selected. If 
accessed from the Quick Analysis window, the Format window will, by default, display 
telemetry parameters. The time selection option will not be enabled. 
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A.8.3.3 Format Window Input 

The Format Window allows the following inputs: 

•	 Selection of Format Name. A user may select title for each format specification. The 
user may read an existing format or create a new format. 

•	 Selection of telemetry parameters based upon subsystem selection. Available telemetry 
parameters are those selected in the parent window. (i.e., the Quick Analysis Window or 
Analysis Request Window). Telemetry parameters are displayed in a double scrolling 
list. The double scrolling list has a list of available parameters associated with a 
subsystem and a list of selected parameters. Using the arrow "----->,<-----," buttons 
below the double scrolling list, the user may select or de-select telemetry parameters. 
The "Find" option highlights a matching parameter with the unique characters entered in 
the "Find" text field. 

•	 Selection of Format Time period using the Time Selector utility. (Time selector is 
described in section (A.3.1). The time period specifies the start and stop time of history 
data associated with a parameter. Time period specifications are bound by the start and 
stop time of the analysis request. Epic times may be specified using the Time Selector. 
Multiple times can be specified and will be displayed in the scrolling list. 

•	 Selection of format options. Format options are for graph, table and info output views 
and will be defined in Release B. 

The "OK" button saves selections to be used for the generation of output products. 

The "Cancel" button ignores any inputs and closes the Analysis Request window. 

The "Help" button provides context-sensitive help. 

A.8.3.4 Format Window Output 

The output of the Format Window selections are reflected in the output product. The Graph and 
Table output products will display the format selections. 
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Figure A.8.1-2. Analysis Telemetry Selector 
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Standing Order Browser 

Sorted by 

Total standing order requests : 4 

User 

EnableModify Delete Products 

95/097 10:00:00 

Close Refresh Help 

Disable 

Product Status as: 

User 

JChung 

JChung 

RBroome data 

VLiang 

Name 

graphRequest 

dataRequest 

plotRequest 

Next start time 

95/105 15:00:00 

95/105 06:00:00 

Status 

Pending 

Completed 

Disabled 

Pending 

Activation Date 

95/095 10:00:00 

95/105 15:00:00 

95/102 10:00:00 

95/075 10:00:00 

Ending Date 

95/09610:00:00 

95/113 15:00:00 

95/150 10:00:00 

95/360 10:00:00 

Frequency 

every 7 days 

every 1 day 

every 5 days 

every 1 month 

Figure A.8.4-1. Standing Order Browser 
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Figure A.8.4-2. Standing Order Product Viewer 
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Figure A.8.4-3. Standing Order Modify Dialog 

A.8.4.1 Standing Order Browser Usage 

The standing order browser contains a browser, a product viewer, and a modify dialog. The 
standing order is either an analysis standing order that is generated from the analysis window or a 
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report standing order that is generated from the report template builder. The standing order 
browser will allow users to view all standing orders in the system. The user will be able to view 
the status of a standing order, as well as enable, disable, delete, and modify standing orders. The 
standing order product viewer allows users to view the completed standing order products, as 
well as products status and sends the selected analysis product to the analysis product selector or 
sends the selected report product to the report editor. The standing order modify dialog allows 
the user to modify the standing order. The user is allowed to modify the standing order request 
name, activation time, ending time, and the standing order frequency by activating the interval 
time selector. 

A.8.4.2 Standing Order Browser Access 

The standing order browser can be accessed from the tools button on the command window. 

A.8.4.3 Standing Order Browser Input 

Standing Order Browser : 

All the standing orders are displayed in an ordered scrolling list. The user can change the order of 
the list to the user name who generated the standing order, the standing order request name, the 
next start time of the standing order, or the status of the standing order using the "Sorted by" 
option menu. 

The user may only select one standing order and then modify, enable, disable, delete, or view the 
products by pressing the modify button, enable button, disable button, delete button, or products 
button. 

Modify button : Activate the standing order modify dialog. 

Enable button : Change the standing order status from "Disabled" to "Enabled". This button will 
be sensitive only when the status of the selected standing order is "Disabled" 

Disable button : Change the standing order status from "Enabled" to "Disabled". This button will 
be sensitive only when the status of the selected standing order is "Enabled". 

Delete button : Delete the standing order. 

Products button : Activate the standing order product viewer window. 

Close button : Close the standing order browser window. 

Refresh button : Get the current standing order information from the standing order manager and 
update the standing order list. 

Help button : Bring up a help window about the standing order browser. 

Standing Order Product Viewer : 

The standing order information such as the user name who submits the standing order, the 
standing order name, the product information, and the time when the standing order browser is 
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invoked are displayed on top of the window. All the completed standing order products

associated with this standing order are displayed in a single select list.


The user can select an analysis product and press the "View Results" button to invoke the

analysis product selector or select an report product and press the "View Results" button to

invoke the report editor.


View Results button : Invoke the analysis product selector or the report editor.


Close button : Close the product viewer window.


Help button : Bring up a help window about the standing order product viewer.


Standing order Modify Dialog :


The user name who submits the standing order is displayed and is not modifiable.


The standing order request name, the activation time, and the ending time can be modified by

entering values to each field in this dialog.


The frequency can be modified by pressing the "Time Select" button to activate the interval time

selection window.


Time Select button : Activate the interval time selection window.


Ok button : Apply the changes and close the dialog.


Cancel button : Cancel the changes and close the dialog.


Help button : Bring up a help window about the standing order modify dialog.


A.8.4.4 Standing Order Browser Output 

The standing order viewer will send the selected analysis product to the analysis product selector 
or the selected report product to the report editor. 

A.8.5 Quick Analysis Window 

A.8.5.1 Quick Analysis Usage 

The Quick Analysis window is used by the user to create display pages of real-time data based 
upon the selection of telemetry parameters. The display pages provide updating displays of real­
time telemetry data in several output views. The Quick Analysis window provides a selection 
filter to allow easy selections of spacecraft subsystems and telemetry parameters and a format 
option for customizing output views. 
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Figure A.8.5-1. Quick Analysis Window 

A.8.5.2 Quick Analysis Access 

The Quick Analysis window can be accessed from the Control Window or from a graph and 
table display page. If the Quick Analysis window is accessed from a graph or table display page, 
all selected parameters, by default , will be displayed as selected parameters in the Quick 
Analysis window. If accessed from the Control Window, available subsystems will be displayed 
for selection. 

A.8.5.3 Quick Analysis Input 

The Quick Analysis window allows the following inputs to create display pages: 

•	 Selection of S/C Subsystem using the Selection Filter (Selection Filter described in 
section A.3.2) 

•	 Selection of telemetry parameters based upon subsystem selection. Telemetry parameters 
are displayed in a double scrolling list. The double scrolling list has a list of available 
parameters associated with a subsystem and a list of selected parameters. Using the 
arrow "----->,<-----," buttons below the double scrolling list, the user may select or de­
select telemetry parameters. The "Find" option highlights a matching parameter with the 
unique characters entered in the "Find" text field. 

•	 Selection of output view(s) using the toggle button. Output views can be a graph, table, 
alphanumeric display or Info window. (Detail describing output views are described in 
section A.6) 
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•	 Selection of output view format options using the "Format" button to access the Format 
Window. Format options are available for graph, table and info product views. Default 
formats are applied if no format options are selected. (Details describing Format 
Windows are describe in section A.8.3) 

The "OK" button initiates the generation the display pages based upon user inputs. 

The "Cancel" button ignores any inputs and closes the Quick Analysis window. 

The "Help" button provides context-sensitive help. 

A.8.5.3 Quick Analysis Output 

The Quick Analysis window outputs the specified output product. The output product can be a 
graph, table, info window and/or alphanumeric window. 

A.8.6 Algorithm Registration 

A.8.6.1 Algorithm Registration Usage 

The Algorithm Registration window is used to enter algorithms into configuration control. 
When an algorithm is registered, the algorithm is checked and validated. The algorithm 
registration status is displayed. 
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Figure A.8.6-1. Algorithm Registration Window 

A.8.6.2 Algorithm Registration Access 

The Algorithmn registration window can be accessed from the Control window. 

A.8.6.3 Algorithm Registration Input 

The Analysis Registration window requires the following inputs: 
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• Algorithm Name - The name of the Algorithmn function. 

• Source File Name- The file name and path of the algorithm source code. 

• Object File Name- The file name and path of the algorithm object file. 

•	 Algorithm Description- A detailed description of the algorithm functionality including 
input and output descriptions. 

The "Select File" button invokes the file selector dialog to allow the user to choose a file name. 

The "Register" button initiates the algorithm registration process. 

The "Cancel" button ignores any inputs and closes the Algorithm Registration window. 

The "Help" button provides context-sensitive help. 

A.8.6.4 Algorithm Registration Output 

The Algorithm Registration window displays the status of the registration process. The input and 
output symbols of successfully registered algorithms will be displayed. Error messages 
containing reasons for failure are also displayed. 

A.8.7 Algorithm Request 

A.8.7.1 Algorithm Request Usage 

The Algorithm Request window is used to select algorithms to be applied on history data for 
analysis. Since algorithms are dynamically linked and loaded, users have the ability to choose 
the values for its input and output arguments. 
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Figure A.8.7-1. Algorithm Request Window 
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Figure A.8.7-2. Algorithm Parameter Selector Window 

A.8.7.2 Algorithm Request Access 

The Algorithm registration window is accessed from the Analysis Request window. 

A.8.7.3 Algorithm Request Input 

The Algorithm Request window requires the following inputs: 
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•	 Selection of Algorithm- The user must select an algorithm name from the list available 
algorithms provided. More than one algorithm may be selected in the Algorithm Request 
window. 

•	 Selection of Algorithm parameters using the "Select Parameters" button to access the 
Algorithm Parameter Selector as shown in Figure A.8.7-2. The Algorithm Parameter 
Selector window provides a list of input and output symbols for the selected algorithm. 
The user must select a telemetry parameter to satisfy each algorithm input symbol. The 
"Filter" button invokes the Selection Filter tool (described in section A.3.2) and provides 
a list of available telemetry parameters. The "Set Parameter" button assigns the selected 
input symbol to the selected telemetry parameter. The user must also supply an output 
parameter name for each output symbol. The user can request the algorithm to use an 
existing dataset as input. An input dataset can be specified for each algorithm. The 
algorithm invocation rate is the rate at which the algorithm is to be applied. The user 
may choose the algorithm to be invoked based on a specified occurrence of a key 
parameter or on a specified seconds timer. 

•	 At the Algorithm Parameter Selector window, the "OK" button applies the selections to 
the selected algorithm and closes the window. The "Cancel" button ignores any input 
and closes the window. The "Help" button provides context sensitive help. These button 
have the same behavior at the Algorithm Request window except that the "OK" button" 
applies all the algorithm selections and closes the Algorithm Request window. 

A.8.7.4 Algorithm Request Output 

The Algorithm Request window displays the algorithm description for each selected algorithm 
and a list the selected algorithms names, input dataset names ( if applicable) and the algorithm 
invocation rate. The user may select an algorithm from the selected list to change parameter 
selections by pressing the "Select Parameters" button. The "Select Parameters" button will 
display the Algorithm Parameter Selector window (Figure A.8.7-2) with the selected algorithm 
input and output values. The user may change the selected values by selecting the input and 
output symbols and assigning them parameters as described in the Algorithm Request Input 
section above. As parameter get assigned, the Algorithm Parameter Selector window will update 
the display of selected input and output parameters accordingly. 

The Algorithm Request window displays the algorithm source file upon selecting the "View 
Algorithm" button. 
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A.9.1 Event Display Window 

Figure A.9.1-1. Event Display Window�
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Figure A.9.1-2. Subsystems Dialog�

Figure A.9.1-3. Event Types Dialog�
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A.9.1.1 Event Display Usage 

The event display will allow the user to request time specific event files from the Data 
Management System, and view these events as well as real-time events. The user can them 
perform searches on the data, filter the data, zoom in on the timeline, and print and save the data. 

A.9.1.2 Event Display Access 

The event display can be accessed by pressing the Tools button on the command window. 
Choose "Event Display" from the Tool Selector. 

A.9.1.3 Event Display Input 

Real-time Events: 

The real-time radio button will be pressed, and real-time events will be scrolling in the 
event display. The marker on the top of the timeline indicates the currently viewed events 
in the scrolled list. Each type of event will be color coded in the timeline and corresponds 
to each event message in the scrolling list. 

TimeLine: 

The timeline may be zoomed in upon by drawing a box around two time periods. 

Zoom Out: This button enables the user to view all of the events in the timeline. 

Scrolled List: 

The user may type a word or partial word to search, and then press enter to search. Once 
the event that meets the criterion is found, it is highlighted. The user presses enter to find 
subsequent occurrences. 

The user may type a word or partial to filter the events. Only those events with filter 
criteria will be shown in the event display. 

Reset:	 The user may press "Reset" to reset to the full event list in the event 
display after searching or filtering on a word or partial word. 

Freeze: 	 The user may press "Freeze" in order to stop the movement of the scrolled 
list in real-time event mode. 

Real-time/History: 
The user may toggle the "Real-time" and "History" buttons to view one or 
the other kind of events. 

Menu: 

File: 

Open:	 This button opens a dialog from which a previously saved event file can be 
loaded into the event display. 

Save: This button saves events in a file. 
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Save As: This button saves events in a file. 

Print: This button prints events. 

Quit: Quits the display. 

Filter: 

Subsystems: 

The user may press "Subsystems" to bring up the filter dialog for subsystems (See Figure 
A.9.1-2). A subsystem may be highlighted, and shown or not shown by pressing the 
toggle buttons. "All" shows all of the subsystems. "None" shows none of the subsystems. 
"Apply" applies the selected criteria to the event display. "Close" closes the filter dialog. 

Event Types: 

The user may press "Event Types" to bring up the filter dialog for event types (See Figure 
A.9.1-3). An event type may be highlighted, and shown or not shown by pressing the 
toggle buttons. "All" shows all of the events. "None" shows none of the events. "Apply" 
applies the selected criteria to the event display. "Close" closes the filter dialog. 

All: This selection shows all the events. 

None: This selection shows no filtered events. 

Options: 

Hide Graph/Show Graph: 

"Hide Graph" will hide the graph, while "Show Graph" will makeit reappear. 

History: 

Retrieve From Archive: 

This selection will bring up the event history request window. When the event 
history file is brought up, the radio button for "History" will be toggled. For more 
information on its use see Section. A.9.2 Event History Request Window. 

A.9.1.4 Event Display Output 

An event file may be saved or printed from this screen. 

A.9.2 Event History Request Window 
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A.9.2.1 Event History Request Usage 

The event history request window is brought up from the event display. It is selected by the user 
to request an event history file, which will be sent to the Data Management System (DMS). In 
turn, DMS will send back the file to the user for viewing in the event display. 
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Filter by Subsystem 
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Figure A.9.2-1. Event History Request Window 

A.9.2.2 Event History Request Access 

The event history request window is accessed by pressing the "History" button from the menu on 
the event display. From there, pick "Retrieve From Archive", and the dialog will appear. 

A.9.2.3 Event History Request Input 

The following inputs are for the event history request: 
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The user must type in: 

File Name - name of file to be sent back to user. 

Target Directory - target directory where returned file from DMS will be placed. 
This will be prefilled with the user's default directory received from the Environment 
Controller. 

Filter by Subsystem: 

Toggle one or more subsystems, or 

Press "All" to select all subsystems. 

Press "None" to de-select all subsystems. 

Filter by Event Type: 

Toggle one or more event types, or 

Press "All" to select all event types. 

Press "None" to de-select all event types. 

Enter Start Time and Stop Time, or 

Press "Set Time" to process more detailed start and stop times for the event history request. 

Press "OK" to process the event history request after start and stop times, subsystem, event types, 
target directory, filename, author, and request name have been filled in. 

Press "Cancel" to cancel the request and quit the window. 

Press "Help" to request help. 

A.9.2.4 Event History Request Output 

The event history request. 
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